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About this document

1 About this document

1.1 Other applicable documents

The information on the safety sensor is distributed over several documents to make working with the docu-
ments easier. You will find the documents and software for the safety sensor in the following table:

Purpose and target group of the document

Document/software ti-
tle

Source

Software for users of the machine ? for safety sen-
sor diagnostics if a fault occurs and for machine de-
sign engineers for configuring the safety sensor

Sensor Studio
DTM RSL 400

Supplied with the safety
sensor on data carrier

Notes for the machine design engineer

"Safe implementation
and operation”
(this document)

PDF, supplied with the
safety sensor on data
carrier

Notes for the machine design engineer  for config-
uring the safety sensor (software instructions)

Online help for software

Supplied with the safety
sensor on data carrier

Notices regarding mounting, alignment and connec-
tion of the safety sensor

"Quick Start Guide
RSL 400"

Print document, supplied
with the safety sensor

a) Machine identifies the product that the safety sensor is installed in.

1.2 Downloading configuration software from the Internet
% Call up the Leuze home page: www.leuze.com.
% Enter the type designation or part number of the device as the search term.
% The configuration software can be found on the product page for the device under the Downloads tab.
1.3 Used symbols and signal words
Tab. 1.1: Warning symbols and signal words
I: Symbol indicating dangers to persons
g Symbol indicating dangers from harmful laser radiation
0 Symbol indicating possible property damage
NOTE Signal word for property damage
Indicates dangers that may result in property damage if the measures for dan-
ger avoidance are not followed.
CAUTION Signal word for minor injuries
Indicates dangers that may result in minor injury if the measures for danger
avoidance are not followed.
WARNING Signal word for serious injury
Indicates dangers that may result in severe or fatal injury if the measures for
danger avoidance are not followed.
DANGER Signal word for life-threatening danger
Indicates dangers with which serious or fatal injury is imminent if the measures
for danger avoidance are not followed.

Leuze electronic
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About this document

Tab. 1.2: Other symbols
Symbol for tips
0 Text passages with this symbol provide you with further information.
Symbol for action steps
S Text passages with this symbol instruct you to perform actions.
Symbol for action results
= Text passages with this symbol describe the result of the preceding action.
Tab. 1.3: Terms and abbreviations
CS Switching signal from a control
(Controller Signal)
DTM Software device manager of the safety sensor
(Device Type Manager)
EDM Contactor monitoring
(External Device Monitoring)
FDT Software frame for management of device managers (DTM)
(Field Device Tool)
Field pair A protective field with an associated warning field
DTS Driverless Transportation System
LED LED, display element in the safety sensor
(Light Emitting Diode)
OSSD Safety-related switching output
(Output Signal Switching Device)
PFH, Probability of a dangerous failure per hour
(Probability of dangerous Failure per Hour)
PL Performance Level
Quad Two field pairs (four fields) that are monitored simultaneously in four field mode
TSS Transverse Side-tracking Skate
RES Start/restart interlock
(Start/REStart interlock)
SIL Safety Integrity Level
State ON: device intact, OSSDs switched on
OFF: device intact, OSSDs switched off
Locking: device, connection or control/operation faulty, OSSDs switched off
(lock-out)

1.4 Checklists

The checklists serve as a reference for the machine manufacturer or supplier (see chapter 11 "Testing").
They replace neither testing of the complete machine or system prior to the initial start-up nor their periodic
testing by a competent person. The checklists contain minimum testing requirements. Depending on the
application, other tests may be necessary.

Leuze electronic
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Safety

Before using the safety sensor, a risk assessment must be performed according to valid standards (e.g.

EN ISO 12100, EN I1SO 13849-1, IEC 61508, EN IEC 62061). The result of the risk assessment determines
the required safety level of the safety sensor (see chapter 15.1 "Safety-relevant technical data"). For
mounting, operating and testing, this document as well as all applicable national and international stan-
dards, regulations, rules and directives must be observed. Relevant and supplied documents must be ob-
served, printed out and handed to affected persons.

% Before working with the safety sensor, completely read and observe the documents applicable to your
task.

In particular, the following national and international legal regulations apply for the commissioning, techni-
cal inspections and work with safety sensors:

* Machinery directive 2006/42/EC

* Low voltage directive 2006/95/EC

« EMC directive 2004/108/EC

» Use of work equipment directive 89/655/EEC supplemented by directive 95/63 EC
+ OSHA 1910 Subpart O

» Safety regulations

» Accident-prevention regulations and safety rules

* Ordinance on Industrial Safety and Health and employment protection act
* Product Safety Law (ProdSG)

For safety-related information you may also contact local authorities (e.g., industrial inspec-
torate, employer's liability insurance association, labor inspectorate, occupational safety and
health authority).

Intended use

The safety sensor protects persons or body parts at points of operation, danger zones or access points of
machines and systems.

A running machine may result in serious injury!

% Make certain that the safety sensor is correctly connected and that the protective function of
the protective device is ensured.

% Make certain that, during all conversions, maintenance work and inspections, the system is
securely shut down and protected against being restarted.

» The safety sensor may only be used after it has been selected in accordance with the respectively ap-
plicable instructions and relevant standards, rules and regulations regarding labor protection and safety
at work, and after it has been installed on the machine, connected, commissioned, and checked by a
competent person (see chapter 2.3 "Competent persons").

* When selecting the safety sensor it must be ensured that its safety-related capability meets or exceeds
the required Performance Level PL, ascertained in the risk assessment (see chapter 15.1 "Safety-rele-
vant technical data").

* The safety sensor may only be used in North America in applications that satisfy the requirements
specified by NFPA 79.

» With the “access guarding” function, the safety sensor detects persons only when they enter the danger
zone but cannot tell whether there are any persons inside the danger zone. For this reason, a start/
restart interlock in the safety chain is essential in this case.

» The construction of the safety sensor must not be altered. When manipulating the safety sensor, the
protective function is no longer guaranteed. Manipulating the safety sensor also voids all warranty
claims against the manufacturer of the safety sensor.

Leuze electronic RSL 420 9
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» The safety sensor must be inspected regularly by a competent person to ensure proper integration and
mounting (see chapter 15.1 "Safety-relevant technical data").

» The safety sensor must be exchanged after a maximum of 20 years. Repairs or the exchange of wear
parts do not extend the mission time.

/\ CAUTION

Observe intended use!

The protection of personnel and the device cannot be guaranteed if the device is operated in a
manner not complying with its intended use.

% Only operate the device in accordance with its intended use.
% Leuze electronic GmbH + Co. KG is not liable for damages caused by improper use.

% Read these operating instructions before commissioning the device. Knowledge of the oper-
ating instructions is an element of proper use.

NOTICE

Comply with conditions and regulations!
% Observe the locally applicable legal regulations and the rules of the employer's liability insur-

ance association.

211 Vapors, smoke, dust, particles

Vapors, smoke, dust and all particles visible in the air can cause the machine to switch off unintentionally.
This can mislead the user into bypassing the safety devices.

% Do not use the safety sensor in environments in which heavy vapors, smoke, dust or other visible parti-
cles occur at the beam level.

21.2 Stray light

Light sources can impair the safety sensor's availability. Interfering light sources are:
* Infrared light
* Fluorescent light
« Strobe light

% Ensure that there are no interfering light sources at beam level.

% Prevent reflective surfaces at beam level.

% Where applicable, take protective field addition distances into account.

% Implement all additional measures to ensure that any special application of any effected beam types
does not impair the safety sensor's operation.

21.3 Obstructions in the protective field

% Do not bring any additional window materials into the area monitored by the safety sensor.

No screen between optics cover and monitoring area!

% Between the optics cover of the safety sensor and the monitored area, no further screen
may be mounted to protect the safety sensor.

Leuze electronic RSL 420 10
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Foreseeable misuse

Any use other than that defined under "Intended use" or which goes beyond that use is considered im-
proper use.

In principle, the safety sensor is not suitable as a protective device for use in the following cases:

» Danger posed by ejected objects or the spraying of hot or hazardous liquids from within the danger
zone.

» Applications in explosive or easily flammable atmospheres.
» Use for outdoor applications or under extreme temperature fluctuations.

Humidity, condensation and other weather influences can impair the protective function.
» Use on vehicles with combustion engines.

Alternators and ignition systems can cause EMC interferences.

NOTICE
0 Do not modify or otherwise interfere with the safety sensor!

% Do not carry out modifications or otherwise interfere with the safety sensor. The safety sen-
sor must not be tampered with and must not be changed in any way.

% The safety sensor must not be opened. There are no user-serviceable parts inside.

% The construction of the safety sensor must not be altered. When manipulating the safety
sensor, the protective function is no longer guaranteed.

% Manipulating the safety sensor voids all warranty claims against the manufacturer of the
safety sensor.

% Repairs must only be performed by Leuze electronic GmbH + Co. KG.

Competent persons

Connecting, mounting, commissioning and adjustment of the safety sensor must only be carried out by
competent persons.

Prerequisites for competent persons:
* They have a suitable technical education.

» They know the rules and regulations for labor protection, safety at work and safety technology and can
assess the safety of the machine.

» They know the operating instructions for the safety sensor and the machine.

» They have been instructed by the responsible person on the mounting and operation of the machine
and of the safety sensor.

» They perform a task related to the subject matter shortly thereafter and keep their knowledge up to date
through continuous further training.
Certified electricians
Electrical work must be carried out by a certified electrician.

Due to their technical training, knowledge and experience as well as their familiarity with relevant standards
and regulations, certified electricians are able to perform work on electrical systems and independently de-
tect possible dangers.

In Germany, certified electricians must fulfill the requirements of accident-prevention regulations DGUV
Regulation 3 (e.g. electrician foreman). In other countries, there are respective regulations that must be ob-
served.

Leuze electronic RSL 420 11
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24 Disclaimer
Leuze electronic GmbH + Co. KG is not liable in the following cases:
* The safety sensor is not used as intended.
» Safety notices are not adhered to.
» Reasonably foreseeable misuse is not taken into account.
* Mounting and electrical connection are not properly performed.
» Proper function is not tested (see chapter 11 "Testing").
» Changes (e.g., constructional) are made to the safety sensor.

25 Laser safety notices — Laser class 1 for wavelength range outside 400 - 700 nm

Additional measures for shielding the laser radiation are not necessary (safe for eyes).

LASER RADIATION - LASER CLASS 1

The device satisfies the requirements of IEC 60825-1:2007 (EN 60825-1:2007) safety regula-
tions for a product of laser class 1 as well as the FDA Radiation Performance Standards,

21 CFR, Subchapter J, Part 1010 and Part 1040 with deviations corresponding to "Laser Notice
/&\ No. 50" from June 24, 2007.

% Observe the applicable statutory and local laser protection regulations.

% The device must not be tampered with and must not be changed in any way.
There are no user-serviceable parts inside the device.

% Repairs must only be performed by Leuze electronic GmbH + Co. KG.

2.6 Responsibility for safety

Manufacturer and operator must ensure that the machine and implemented safety sensor function properly
and that all affected persons are adequately informed and trained.

The type and content of all imparted information must not lead to unsafe actions by users.
The manufacturer of the machine is responsible for:

« Safe machine construction

» Safe implementation of the safety sensor, verified by the initial test performed by a competent person

* Imparting all relevant information to the operating company

» Adhering to all regulations and directives for the safe commissioning of the machine
The operator of the machine is responsible for:

* Instructing the operator

* Maintaining the safe operation of the machine

» Adhering to all regulations and directives for labor protection and safety at work

» Regular testing by competent persons

Leuze electronic RSL 420 12
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3 Device description

The safety sensors from the RSL 400 series are optoelectronic, two-dimensional measuring safety laser
scanners. They satisfy the following standards:

RSL 400
Type in accordance with IEC/EN 61496 3
Category in accordance with EN I1ISO 13849 3
Safety Integrity Level (SIL) in accordance with IEC 61508 2
SILCL in accordance with IEC/EN 62061 2
Performance Level (PL) in accordance with EN ISO 13849-1 d

Scanner unit

Connection unit

Optics cover

Alphanumerical display (displayed)
LED indicators

a ~ ON =

Fig. 3.1: Device overview of RSL 400 safety laser scanners

Leuze electronic RSL 420 13
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Device description

3.1

All safety sensors of the RSL 420 series are equipped as follows:

» Laser scanner with the range class S, M, L or XL:

Operating range Operating range [m]
class

S 3.00

M 4.5

L 6.25

XL 8.25

« 24-digit alphanumerical display

* Integrated electronic spirit level for aligning the safety sensor

e LED indicator
e Connection unit:
» Configuration memory

» Ethernet connection for communication and configuration with the PC/laptop

« Electrical connection to the machine via connection cable

Device overview

The following table provides an overview of the possible uses, features and functions of the RSL 400 safety

sSensors.
Tab. 3.1: Device overview
RSL 410 RSL 420 RSL 430 RSL 440
RSL 425 RSL 445
Stationary danger zone guarding X X X X
Mobile danger zone guarding X X X X
Access guarding X X X X
Point of operation guarding X X X X
Safety-related switching outputs 1 OSSD pair 1 OSSD pair |2 OSSD pairs |2 OSSD pairs
Protective function A X X X X
Protective function B - - X X
Signal outputs Upto 3 Upto 4 Upto9 Upto9
Configurable signal outputs X X X X
Number of changeover-capable pro- 1 10 10 +10 100
tective/warning field pairs
E-stop linkage - X X X
Four field mode (quads) X X X X
Internal safe time delay - - X X
Measurement data output optimized - Only RSL 425 |- Only RSL 445

for vehicle navigation

Protective function of RSL 400 safety sensors

The safety sensor transmits periodic light pulses via a rotating deflection unit. The light pulses are scattered
in all directions by obstacles, e.g. persons. A part of the light pulses is received again by the safety sensor
and evaluated. The safety sensor calculates the precise position of the object from the propagation time of
the radiated light and the current angle of the deflection unit at that time. If the object is within a predefined
area, the protective field, the safety sensor performs a safety-related switching function. It switches the

safety-related switching outputs off.

Leuze electronic
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3.2

Only when the protective field is free again does the safety sensor reset the safety-related switching func-
tion, either automatically or following acknowledgment, depending on the operating mode.

The safety sensor can even detect people when they are wearing very dark clothes, which have a very
weak diffuse reflectance.

Parameters for protective function

The following parameters for switching off the safety-related switching outputs of the safety sensor are
taken into consideration for the protective function:

» Configurable protective fields
» Reference contour of protective fields
» Configurable field pair changeover
» Selectable resolution for hand, leg or body detection
» Safety sensor response time
» Selectable start-up behavior
The following non-safety-oriented functions and signals also belong to the protective function:
« Configurable warning fields
» Configurable indication signals
Additional functions of the protective function
* Warning field evaluation
» Selectable dynamic contactor monitoring (EDM)
» E-Stop

Device and monitoring functions
* Monitoring and release of field pair changeover

Connection unit
The safety sensor is mounted, connected and aligned using the connection unit.

2
M5 2x — [ O
|
|| }
1 Connection cable, connection to the machine
2 M12 socket, D-coded, Ethernet communication connection

M5 Connection for functional earth with M5 x 10 self-cutting/self-tapping (gas tightness) and ground strap

Fig. 3.2: Device overview, connection unit
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3.3

3.31

Functions of connection unit:

» Attachment point for mounting, either directly or using an optional mounting system.
When devices are swapped out, the connection unit remains mounted and aligned.

« EMC wiring for signal inputs/outputs and supply using connection cable

Safety sensor Connection unit Connection
RSL 420 CU416-y Connection cable, 16-wire
y=5000, 10000, 25000 5m,10m, 25 m

» Connector bushing and EMC for the Ethernet TCP/IP communication and configuration interface to the
PCllaptop

* Memory for the configuration files and automatic parameter transfer in the event of device swap-out
» Quick-release connection to the scanner unit (see Quick Start Guide) for easy device swap-out

Display elements
The display elements of the safety sensors simplify start-up and fault analysis.

LED indicator
Located on the connection unit are the LEDs for displaying the operating state.
* Protective function A: LEDs 1, 2, 3

—_A B
) == @A u
@ © ® ©
Tab. 3.2: Meaning of the LEDs
LED Color State Description
1 Red/green |OFF Device switched off
Red OSSD off
Red, flashing Error
Green OSSD on
2 Yellow OFF RES deactivated
RES activated and enabled
Flashing Protective field occupied
ON RES activated and blocked but ready to be unlocked
Protective field free and linked sensor enabled (if applicable)
3 Blue OFF Free warning field
ON Warning field interrupted
4 Blue OFF Four field mode: warning field 3 free
ON Four field mode: warning field 3 interrupted
5 Yellow Flashing Four field mode: warning field 2 interrupted
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3.3.2 Alphanumerical display

In normal operation, the 24-digit alphanumerical display of the safety sensor shows the monitored protec-
tive and warning field pairs. It also provides assistance during detailed error diagnostics (see chapter 12
"Diagnostics and troubleshooting").

Tab. 3.3: Alphanumerical displays

Display Description Example

Upon startup without configuration/upon initial commissioning

Sensor type Sensor type 420M

Sensor serial number Sensor serial number SN: 21513123456
Sensor name / Network name Name of the sensor / network A123456789
Configuration necessary Configuration required CONFIG REQUESTED

Repeated until end of booting phase / start phase, then

Spirit level permanent Horizontal alignment in degrees: H |H -3°V +9°
Vertical alignment in degrees: V

Upon startup with configuration

Sensor type Sensor type 410XL

Sensor serial number Sensor serial number SN: 21513123456

Sensor name / Network name Name of the sensor / network A123456789

IP: DHCP/FIX DHCP or permanent IP address IP: DHCP or
10.25.45.2

Bluetooth on/off Bluetooth detection ON/OFF Bluetooth ON

Date of configuration Date of configuration 11/13/2014 08:15

Signature Signature of configuration DG45L8zU

Level Horizontal alignment in degrees: H | H-3° V+9°

Vertical alignment in degrees: V

Repeated until end of booting phase / start phase, then

Display following configuration of normal operation

e.g. display of active field pair A1.1
Transfer of the configuration data

AWAITING CONFIG Until downloading of configuration data is confirmed
DOWNLOAD CONFIG During transfer of configuration data

Level

H+/-.°V+/-.° Horizontal alignment in degrees: H |H -3° V +9°

Vertical alignment in degrees: V

Sensor detection

PING received Display for identification by device PING received Device name
name

Message

Message via a signal output or diag- | ProtF A: E123

nosis 1D Device: P007 - wrong Config

Leuze electronic RSL 420 17
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3.33

3.4

3.5

Display Description Example
Error diagnostics
F... Failure, internal device error
E... Error, external error
u... Usage info, application error
... Information
P... Parameter, inconsistency in the con-
figuration

For error diagnostics, the error's respective letter is displayed first followed by the number code. An Au-
toReset is carried out after 10 seconds for errors that do not cause locking, with an unauthorized restart be-
ing impossible. In the case of blocking errors, the voltage supply must be separated and the cause of the
error must be eliminated. Before switching on again, the steps taken before initial commissioning must be
repeated (see chapter 10 "Starting up the device").

When the protective field has been free for about 5 seconds, the device switches back to the display in nor-
mal operation.
Displays in normal operation

The display in normal operation depends on the operating state of the safety sensor. The display can be
switched off or rotated by 180° by means of the software.

Field-of-view display

The upper and lower limit of the safety sensor's field of view can be displayed by means of horizontal lines
on the optics cover.

% Make sure that the safety sensor's field of view is always completely unobstructed.

NOTICE
Always check the protective field configuration!
% Check all defined protective fields each time the configuration is changed.
The field-of-view display is a comfort function and is not intended as a substitute for check-
ing the protective field configuration.

% The safety sensor's field of view must be completely unobstructed on the application side.

Mounting system (optional)

Mounting systems and mounting brackets simplify mounting and alignment of the safety sensor. Mounting
systems and mounting brackets are available as accessories (see chapter 17 "Order guide and acces-
sories").

Loop guard (optional)

The loop guard for the optics cover prevents damage to the safety sensor caused by light contact with for-
eign objects. The loop guard is available as an accessory (see chapter 17 "Order guide and accessories").

Leuze electronic RSL 420 18



& Leuze electronic Configuration and diagnostic software Sensor Studio

4 Configuration and diagnostic software Sensor Studio

To start up a safety sensor in your application, the safety sensor must be set up according to its specific
use using the configuration and diagnostic software. The software is used to set up the safety configuration
of the safety sensor, to change the communication and diagnostics settings and to perform diagnostic rou-

tines. Communication takes place via the PC.
The software is designed according to the FDT/DTM concept:
* You make the individual configurations for the safety sensor in the Device Type Manager (DTM).

» The individual DTM configurations of a project can be called up via the frame application of the Field

Device Tool (FDT).

» Each device DTM has a communication DTM that sets up and monitors the communication connec-
tions to the sensor.

Only use the software for safety sensors manufactured by Leuze electronic.

4.1 System requirements
To use the software, you need a PC or laptop with the following specifications:

Hard disk space At least 250 MB free memory
If you want to save the protective field or configuration values, you will
need more memory.

Screen display Color

External drive DVD drive

Input device Keyboard and mouse or touchpad
Output device Printer (black-white or color)
Interfaces RJ45 Ethernet network

ogy, use an appropriate USB or PCMCIA adapter if necessary.

Bluetooth (optional) - If the PC does not have integrated Bluetooth technol-

Operating system Microsoft® Windows 7 and Windows 8.1

Only the term "PC" is used below.

4.2 Installing software
Prerequisites:

* You do not need the safety sensor to install the software on the PC.
» All Windows applications are closed.

The software is installed in two steps:
% Installing the Sensor Studio FDT frame.

% Installing LeSafetyCollection device manager (DTM).

Leuze electronic RSL 420



& Leuze electronic Configuration and diagnostic software Sensor Studio

Installing the Sensor Studio software

If FDT frame software is already installed on your PC, you do not need the Sensor Studio instal-
lation.

You can install the device manager (DTM) in the existing FDT frame.

% Insert the data carrier.

= The installation will start automatically.

% If installation does not start automatically, double-click the file SensorStudioSetup.exe.

% If you want to call up the menu of the CD, double-click the file start.exe.

% Select a language for the interface text in the installation wizard and software and confirm with [OK].
= The installation wizard starts.

% Click [Next].

= The installation wizard opens the software license agreement.

% If you want to accept the license agreement, select the appropriate option field and click [Next].

% If the suggested installation path is OK, click [Next].
If you want to specify a different path, click the [Browse] button. Select a different path, confirm with
[OK] and click [Next].

% Click the [Install] button to start installation.

= The wizard installs the software and places a shortcut on the desktop (d).
% Click the [Finish] button to complete installation.

Installing LeSafetyCollection device manager (DTM)
Prerequisites:
* The Sensor Studio software is installed on the PC.
» Data carrier inserted.
% Double-click the file LeSafetyCollectionSetup.exe.
% Select a language for the interface text in the installation wizard and software and confirm with [OK].
= The installation wizard starts.
% Click [Next].
= The installation wizard opens the software license agreement.
% If you want to accept the license agreement, select the appropriate option field and click [Next].

% If the suggested installation path is OK, click [Next].
If you want to specify a different path, click the [Browse] button. Select a different path, confirm with
[OK] and click [Next].

% Click the [Install] button to start installation.
= The wizard installs the software.
% Click the [Finish] button to complete installation.

NOTICE

During installation of the software, a user admin (without password query) is created so that you

can start the software without user identification. If other users are registered (Tools > User

management in the FDT frame menu), you must log in at the software with a user name and
password.

This setting allows you to connect to the safety sensor and to read out, upload, enter or change
the safety configuration and all settings using the RSL 400 device DTM. The password for the
safety sensor only needs to be entered (i.e. the access level only needs to be changed) when
the changes are downloaded to the safety sensor (see chapter 4.5.1 "Selecting access level").
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4.3 User interface

& Leuze electronic

IDENTIFICATION PROCESS CONFIGURATION  DIAGNOSTICS SETTINGS

| IDENTIFICATION SAFETY LASER SCANNER RSL 400 INFORMATION AREA
B Safely laser scanner RSL 400 .
= Senshrnd pornfguaion ik This window provides context-related help

= Technical data for every dialog of the Configuration and
Diagnostics Software. The help explains

To put RSL 400 Safety Laser Scanners into operation at your application, you must use the cailicaihannlins fod Seoliecs A

l Configuration and Diagnostics Software and adapt the Safety Laser Scanner for operation. of the RSt 40 Saleny | aser Sommer by

describing meaning, function,
consequences, and value range.

| - You can find
« safety configurations in the CONFIGURATION tab.
« communication settings In the SETTINGS tab at Communication.
« diagnostics information in the DIAGNOSTICS tab.
. www leuze.com o the latest operation status in the PROCESS tab. B \@
Refer to the structure of the navigation area and to the help dialogs in the information area.

Using the Configuration and Diagnostics Software, you can define the safety configuration of
- the Safety Laser Scanner, change diagnostics stiings and get diagnostics information.

Pconlected 0 Observer

FDT frame menu with toolbar
RSL 400 device manager (DTM)
Navigation tabs

Information area

Dialog box

Status line

Navigation area

~NOo b ON -

Fig. 4.1: User interface of the software

FDT frame menu
The device managers (DTM) of the safety sensors are created and managed in the FDT frame menu.

Device manager DTM

Configuration projects for setting up the selected safety sensor are created and managed in the device
managers (DTM) of the safety sensors.
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Project tree view

e T A e
Fle Edt View Device Tools Window ?
3 g DB M2 80P PICCH ~ of
[ 1w project Tree -+ < JICEEN BRsL4001 ®asLf0 ® sl 400 a - x
= 3 New Pr
S RSL400-Demo & Leuze electronic
® st a0 Tl S the people
) ® Rs(d001
® RsL400_2
p e IDENTIFICATION PROCESS CONFIGURATION  DIAGNOSTICS SETTINGS
¥ RsL 4004 ©, .
e - @ e
IDENTIFICATION SAFETY LASER SCANNER RSL 400 INFORMATION AREA
ol ssecsamon FESE ) This window provides contexi-related help
Sensorand configuration data P %
= T ochnical dats for every dialog of the Configuration and
3 Diagnostics Software. The help explains
To put RSL 400 Safety Laser Scanners into operation at your S S 5 R
appiication, you must use the Configuration and Diagnostics R A0 Bty s o by
Software and adapt the Safety Laser Scanner for operation. USNG e iing meaning, functon,
the Configuration and Diagnostics Software, you can define the i mHERATE ge
safety configuration of the Safety Laser Scanner, change d i
- diagnostics stiings and get diagnostics information.
You can find
« safety configurations in the CONFIGURATION tab.
www leuze.com » communication settings in the SETTINGS tab at
Communication.
« diagnostics information in the DIAGNOSTICS tab.
« the latest operation status in the PROCESS tab.
Refer 1o the structure of the navigation area and to the help dialogs
in the information area.
UcComnected T Observer
min

FDT frame menu
Device manager (DTM) tabs
Project tree view

1
2
3

Fig. 4.2: User interface with project tree view

The project tree view shows the structure of the currently installed device managers (DTM). In the project
tree view you can, for example, add copies of an already configured device manager (DTM) quickly and
easily to the DTM structure if you want to operate multiple safety sensors with the same configuration set-

tings.

Example: DTS with safety sensors on front and rear side

FDT frame menu

4.4

Help menu item in the menu [?].

You can find complete information on the FDT frame menu in the online help system. Select the

441 Project wizard

Using the Project Wizard you can create and change configuration projects for setting up the safety sensor
(see chapter 4.5 "Using configuration projects").

& Start the Project Wizard in the FDT frame menu by clicking the & | button.

Sensor Studio Options.

Information on the Project Wizard can be found in the online help for the FDT frame menu under

Leuze electronic
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44.2

443

444

DTM change

The DTM Change function makes it easier for you to call up the communication DTM of a device or change
from device DTM to communication DTM.

& Start the DTM change function in the FDT frame menu by clicking the =1, button.

Information on DTM change can be found in the online help for the FDT frame menu under Sen-
sor Studio Options.

User management

Using the user management in the FDT frame menu, you can create users, log users in/out and manage
passwords.

Creating users

When creating a user in the user management via Tools > User management in the software frame
menu, select the access level for the user. For information on access permissions and access levels (see
chapter 5.1 "Authorization concept of safety sensor").

% In the FDT frame menu, click Tools > User management > Create user.

Logging users in/out
Prerequisites:
» Users have been created
% In the FDT frame menu, click Tools > Log in/log out.

Managing passwords
Prerequisites:

» Users have been created
% In the FDT frame menu, click Tools > Change password.

Password management via the FDT frame menu applies to all installed device managers (DTM)
of the project.

Whenever write access occurs, the safety sensors of the RSL 400 series always check the ac-
cess level (Engineer, Expert) and the password defined via the device manager (DTM) (SET-
TINGS > Passwords) independently of the password management via the FDT frame menu.

Exiting Sensor Studio

When you have finished making the configuration settings, close the configuration and diagnostics soft-
ware.

% Exit the program via File > Exit.
% Save the configuration settings as a configuration project on the PC.
You can open the configuration project again at later time via File > Open or with the Sensor Studio Project

Wizard (& ).
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4.5 Using configuration projects

Configuration projects are created and managed in the device manager (DTM) of the selected safety sen-

Sor.

password.

This setting allows you to connect to the sensor and to read out, upload, enter or change the
safety configuration and all settings using the RSL 400 device DTM. The password for the sen-

sor only needs to be entered (i.e. the access level only needs to be changed) when the changes
are downloaded to the safety sensor (see chapter 4.5.1 "Selecting access level").

NOTICE

During installation of the software, a user admin (without password query) is created so that you
can start the software without user identification. If other users are registered (Tools > User
management in the FDT frame menu), you must log in at the software with a user name and

% Start the configuration and diagnostics software on the PC by double-clicking the d button.

= The mode selection of the Project Wizard is displayed.

= If the mode selection is not shown, start the Project Wizard in the FDT frame menu by clicking the

[Project Wizard] button ( & )

File Edit View Device Tools Window ?

Mode selection

BoWég e aig Dp. bl O PPl oo B0
@ sensor Studio =l
@ Sensor Studio 4 Leuze electronic
“ Project Wizard ol B

Define the subsequent procedure.

O Device selection with device search and establishment of connection (online)
) Device selection without communication connection (offline)

Opering & stored project file

admin

Fig. 4.3: Project wizard
% Select the configuration mode and click [Next].
= Automatic connection to a connected safety sensor (Online)
= Device selection without communication connection (offline)
= Load a saved project again
= The project wizard displays the SEARCH DEVICES dialog box.
% Select the interface and click the [Start] button.
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% Find the safety sensor for your configuration project using the search function of the communication

DTM.

Bl208

- -
File Edit Vidw Device Tools Window ?
BobWég. e cop Dog bW &30 P PACCS 4

%Rt BRsLa0 1 2R/

a - x

BRSL400:

Communication DTM

LAN iyetooth / Serial

DTM LIST OF PROJECT

DTM neme | Interface | Device name | Search
RSL400 |LAN A21503001954 | # Seerch | RSL400
RSL400_1 [LAN | A21503001956 RSL400
RSL 4002 |LAN
RSL400_3 |LAN
RSL400_4 |LAN
RSL400_5 |LAN

Device family | Device type | Address Description
400Demo  193.100.248.198 #13

410M 193.100.248.191 sm Test 1SF4F
RSL400

RSL400

RSL400

RSL400

< Connected

& Leuze electronic

the people

@ & |

FDT frame menu
Communication DTM
Device list

Search function

A ODN =

Fig. 4.4:

Communication DTM with search function

= The project wizard displays the device list of configurable safety sensors in the SEARCH DEVICES di-

alog box.

iFlle Edit View Device Tools Window 7
BoMap. e g Dg bl s 30 PP GG Bl 08

@l sensor Studio

[EET=>

) Sensor Studio

“ Project Wizard

& Leuze electronic

21503001954
21503001956

RSL400
RSL400

400Demo
410M

the ie
[ Setting communication parameters pecet

SEARCH DEVICES

Select interface

Interface [Lan -
Adspter ‘ 193.100.248 125 [00000007] Intel(R) Ethemnet Connection 1218-LM - ‘
Search options

Search

(B san |
Select device
Devicename  Devicefamily Devicetype Address Description

SERVICETESTER| RSLE0D 193 100246 152
193100248198 #13
193.100.248191 sm Test 1SF4F

Cancel

admin

Fig. 4.5: Device selection in project wizard

% Select the safety sensor from the device selection list and click [Next].

= The device manager (DTM) of the safety sensor shows the initial screen for the configuration project.
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451

| Fie Bt Vow Dovien: Tods Wkow: 9
BuHby g0 g b il & 80 PP CCN o w0y
|| ® RSL 400 - Main operation | B RSL400 1- B RSL 400 2- Main op  RSL 400_3 - Main operation | 4 LeCommintertace - Main operation = X
RSL400-Demo & Leuze electronic
Range: 825 m
the people
IDENTIFICATION PROCESS (e GTETLTT  DIAGNOSTICS SETTINGS
| G En
I CONFIGURATION ADMINISTRATION ADMINISTRATION
g Administralion N
= OS = EONPIGHRATION DA TA Administration and documentation of the
=" Profective Funclion A Configuratien name safety configuration of the sensor.
&~ Bank Al £, s Using the safety configuration projects,
&0 A1 i o] - saved safety configurations can be clearly
w Ol A12 < identified and retrieved, e.g. to compare
w0 A13 saved configuration data or to identify a
= Responsible person
B D% Al4 sensor for certain tasks.
O A1LS Machine 1D
wE A16
= Proteciive Fincion B Configuration date 7/20/2015 103010 AM
=7 Bank B1
SO BT Signature 7724381C
=~ Changeover order x
= Outputs * | PROJECT DATA
= Other Project name New Project
I
Next> |
Fconnected T Observer
admin
Fig. 4.6: Initial screen for safety configuration

The device manager (DTM) starts without querying the access level of the user. During commu-
nication with the safety sensor, the safety sensor does however query the access level of the
user. To change the access levels (see chapter 4.5.1 "Selecting access level").

Setting device manager

Using the menus of the device manager (DTM) you can set the parameters of the safety configuration. The
online help system provides information on the menu items and adjustment parameters. Select the Help
menu item in the menu [?].

Selecting access level

Using the device manager you can change the access level of the user if necessary.

For the authorization concept of the software, see chapter see chapter 5.1 "Authorization concept of safety
sensor".

% Click in the DTM menu bar on the [Change access level] button (E).
= The Change access level dialog box opens.

% In the Access level list, select the item Expert, Engineer or Observer and enter the default password or
the password defined for the individual user.

The following access levels are available:
» Observer can read everything (no password)
» Expert can change communication and diagnostics settings (default password = comdiag)
» Engineer can additionally change the safety configuration (default password = safety)
The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).
% Confirm with [OK].
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4.5.2

4.5.3

454

45.5

IDENTIFICATION

Detailed information on the menu items and setting parameters can be found in the information area and in
the online help. Select the Help menu item in the menu [?].

* RSL 400 safety laser scanner
« Sensor and configuration data
» Technical data

PROCESS

Detailed information on the menu items and setting parameters can be found in the information area and in
the online help. Select the Help menu item in the menu [?].

» Sensor display
Device display in the DTM menu

+ SENSOR DISPLAY
+ STATE OF THE ACTIVE PROTECTIVE AND WARNING FIELDS
+ SENSOR DATA
* Measurement contour
* Inputs / outputs
+ SENSOR DISPLAY
« CONNECTIONS AND SIGNALS
» Simulation — only with access level Engineer
* Measurement contour
* Inputs / outputs

CONFIGURATION
see chapter 9 "Configuring the safety sensor"

You can only transfer changes made in the CONFIGURATION menu to the safety sensor if you
are logged in with the access level Engineer.

DIAGNOSIS
Adjustment / Alignment
Display of safety sensor alignment using the integrated electronic spirit level
Prerequisites: The software and safety sensor are connected.

% In the DIAGNOSIS menu, click the [Align sensor mechanically] button ().

= The safety sensor display shows the horizontal and vertical alignment in degrees.
Visually identify device

If you have installed multiple safety sensors, identify the safety sensor that is connected to the currently
open device manager (DTM).

Prerequisites: The software and safety sensor are connected.
% In the DIAGNOSIS menu, click the [Visually identify sensor] button (gm).
= In the display of the safety sensor connected to the device manager (DTM), the message "PING re-
ceived" flashes for ten seconds.
Reset sensor
Acknowledge messages and faults
Set safety sensor to safety mode
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4.5.6

Create and save service file
The service file contains all available information on the safety sensor as well as configuration and settings.

When requesting support, send the service file to the Leuze electronic customer service (see chapter 14
"Service and support").

Sensor display

Device display in the DTM menu
+ SENSOR DISPLAY
+ STATE OF THE ACTIVE PROTECTIVE AND WARNING FIELDS
+ SENSOR DATA

Diagnostics list

Access list

EventLog

SETTINGS

You can only transfer changes made in the SETTINGS menu to the safety sensor if you are
logged in with the access level Engineer.

Communication

* LAN
+ DHCP
+ CONNECTION SETTINGS
* MAC address

* Bluetooth
 Activate Bluetooth module
» Activate device scan
* Bluetooth address

EventLog

Trigger signals output when certain events occur, are recorded and shown in the event list of the safety
Sensor.

Information on the monitored signals can be found in the information area and in the online help. Select the
Help menu item in the menu [?].

Sensor display

Activation of the safety sensor alphanumerical display.

Information on the display options can be found in the information area and in the online help. Select the
Help menu item in the menu [?].

Passwords

If a user has forgotten his password for login at the safety sensor or has repeatedly entered the
password incorrectly, he cannot log in at the safety sensor. The CHANGE PASSWORD function
is therefore not available.

To reset the password, a user must generate a reset password and have it confirmed by the
manufacturer.
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CHANGE PASSWORD

% Define individual passwords for the access levels Engineer and Expert. These passwords replace the
default passwords set by the manufacturer.

The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).
Reset password
Prerequisites:
» The software is connected to the safety sensor.

% Generate a one-time password.
Note down the generated reset password.

% Send the reset password to the Leuze electronic customer service for confirmation (see chapter 14
"Service and support").
The device can now be switched off and the connection can be terminated.

% Enter the confirmed reset password and create a new password.

Optics cover
» Monitoring of optics cover
 Dialog box for calibrating a replacement optics cover

Field editor display options

Display settings for the field editor when defining protective/warning fields.
+ CONTOUR ALIGNMENT
+ COORDINATE DISPLAY
+ EDITOR BEHAVIOR

Information on the display options can be found in the information area and in the online help. Select the
Help menu item in the menu [?].
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5.1

Functions

The functions of the safety sensor must be matched to the respective application and its safety require-
ments. You can activate/deactivate the functions and adapt them using parameters. You configure the
functions with the help of the configuration and diagnostics software (see chapter 9 "Configuring the safety
sensor").

» You configure the functions of the safety sensor in the software as configuration projects.

 In each configuration project you determine the protective function and the configurable field pairs via
the selected function mode.

» The changeover-capable protective/warning field pairs for the selected function mode are defined in
configuration banks.

* You determine the resolution, the start-up behavior, the response time and, where applicable, the vehi-
cle speed together for all protective/warning field pairs of a configuration bank.

Authorization concept of safety sensor

User management allows target-group-oriented communication between the software and the safety sen-
sor. Which functions are available depends on the selected access level of the user. For information on
the software and on user management (see chapter 4 "Configuration and diagnostic software Sensor Stu-
dio").
« Changing the safety configuration as well as the communication and diagnostics settings of the sensor
is only permitted for certain access levels.
* Installation and operation of the software do not depend on the access level of the user.

The following access levels are available:

Tab. 5.1: Access levels and functions available
Access level Functions
Observer » Display the measurement contour

» Upload and display configuration data from the safety sensor
 Display status information from the safety sensor

 Display diagnostics list

» Customize display

» Display and evaluate the measurement contour

» Load configuration data from the safety sensor

+ Load status information from the safety sensor

» Display diagnostics list

» Create service file

* Reset password

Expert In addition to the functions of the Observer

» Load the signed safety configuration from a file and transfer/download to
the safety sensor

» Transfer changed communication and diagnostics settings from the PC
to the safety sensor

 Print configuration data incl. protective/warning fields

 Calibrate optics cover
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5.2

Access level Functions

Engineer In addition to the functions of the Expert, full access to all user-relevant func-
tions and parameters:

Create and change a safety configuration:
» Save configuration data to file
» Change all parameters of configuration
* Reset safety sensor to default values
» Define and change protective/warning fields
» Set reference contour in protective field
» Print and delete protective/warning fields
* Load protective/warning field data from file
» Save protective/warning field data

+ Transfer protective/warning field data from the PC to the safety sensor
» Change passwords

The software saves individual passwords in the connected safety sensor, thereby ensuring that
only authorized users can change the existing configuration.

Determining access level

When creating a user in the user management via Tools > User management in the FDT frame menu, se-
lect the access level for the user. In the user management you can also create and change passwords for
the users.

Using the device manager (DTM) you can change the access level of the user (see chapter 4.5.1 "Select-
ing access level").

% Click in the DTM menu bar on the [Change access level] button (E).

Function modes of safety sensor

You configure the functions of the safety sensor in configuration projects with the help of the configuration
and diagnostics software. In each configuration project you determine the protective function and the con-
figurable field pairs via the selected function mode.

You select the function mode of the safety sensor in the software device manager (DTM) with CONFIGU-
RATION > OSSDs (see chapter 9 "Configuring the safety sensor").

You use the protective function to define the criteria for switching off the safety-related switching outputs
(see chapter 3.1.2 "Parameters for protective function").

The changeover-capable protective and warning field pairs for the selected function mode are defined in
the configuration banks, e.g. CONFIGURATION > Protective function A > Bank A1.

Overview of the function modes

Tab. 5.2: Function modes
Function mode Field pairs (FP) Field pair activation
Protective fields (PF)
Warning fields (WF)
One protective function 1FP/1PF+1WF Fixed selection of one field pair
5FP/5PF +5WF Selection by signal input:
* Overlapped monitoring
10 FP /10 PF + 10 WF Selection by signal input:
» Fixed changeover moment
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5.21

5.2.2

Function mode Field pairs (FP) Field pair activation
Protective fields (PF)
Warning fields (WF)

One protective function —four (1 FP/1PF + 3 WF Fixed selection of one field pair
field mode 10 FP+ 10 FP / 10 PF + 30 WF Selection by signal input:

» Fixed changeover moment

One protective function

Ten changeover-capable field pairs for safety-related switching outputs OSSD-A. For the field pair
changeover, see chapter 5.7 "Field pair changeover".

One protective function — four field mode
The safety sensor monitors one protective field and three warning fields.

Monitoring is performed together for the field pairs of protective function A and protective function B. If, for
example, the control system is monitoring field pair A1.1 for protective function A, field pair B1.1 for protec-
tive function B is also monitored.

® @ ®

1 Protective function A: protective field
2 Protective function B: protective field
3 Protective function A: warning field
4 Protective function B: warning field
Fig. 5.1: Four field mode

If the protective field of protective function A is violated, safety-related switching outputs OSSD-A switch.

If the protective field of protective function B is violated, the indication signal B-CLEAR is generated — the
safety-related switching outputs do not switch.

The signals are assigned to the switching outputs via the configuration and diagnostics software (CONFIG-
URATION > Outputs; see chapter 9 "Configuring the safety sensor").

Tab. 5.3: Example: Assignment of signals to switching outputs

Logic signal |Electrical switching output Description

OSSD A Safety-related switching outputs OSSD A | Protective function A: protective field violation
B-CLEAR Switching output MELD — not safe Protective function B: protective field violation
A-WF-VIO Switching output A1 Protective function A: Violation of warning field
B-WF-VIO Switching output EA1 Protective function B: Violation of warning field
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5.3

5.4

5.5

Selectable resolution for hand, leg and body detection

The application-specific resolution of the safety sensor is defined in the configuration project together for all
protective/warning field pairs of a configuration bank.

Tab. 5.4: Resolution of the safety sensor depending on the function

Safety sensor resolution |Function Application(s)

[mm]

30 Hand detection Point of operation guarding

40 Arm detection Point of operation guarding

50 Leg detection with the safety sensor | Danger zone safeguarding

mounted close to floor level

60 * Leg detection with the safety Stationary danger zone safeguarding
sensor mounted at a height of Mobile danger zone safeguarding
150 mm

» Leg detection and detection of
lying persons in the case of
mounting on vehicles, mounting
height approx. 200 mm

70 * Leg detection with the safety Stationary danger zone safeguarding
sensor mounted at a height of Mobile danger zone safeguarding
300 mm

150 Body detection Access guarding

Mobile side guarding

Mounting height = Height of the scan level above floor level

Speed-dependent protective function for vehicles

For object detection in the case of mobile applications, the safety sensor evaluates the relative speed of the
object. If the safety sensor is mounted on vehicles or on moving parts of machines, the maximum speed of
the vehicle must be entered during configuration of the protective function.

The maximum vehicle speed (Max. DTS speed) is selected in the configuration project together for all pro-
tective/warning field pairs of a configuration bank.

Response time

The response time is the maximum time from a protective field violation to switch-off of the safety-related
switching outputs.

The response time is selected in the configuration project together for all protective/warning field pairs of a
configuration bank.
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5.6

5.6.1

5.6.2

Configurable start-up behavior

The start-up behavior is selected in the configuration project together for all protective/warning field pairs of
a configuration bank.

Automatic start/restart

The machine starts automatically as soon as the machine is switched on or the supply voltage returns and
when the protective field is free again.

Using automatic start/restart

You can use the automatic start/restart function under the following prerequisites:

» The start/restart interlock function is taken over by a downstream safety-related component of the ma-
chine control system.

or:
+ lItis not possible to walk behind or go around the effective protective field.
% Allow for an optical and/or acoustic start warning.

Automatic start-up
The automatic start-up function starts the machine automatically as soon as the supply voltage is present.

Automatic restart
The automatic restart function starts the machine automatically as soon as the protective field is free again.

Start interlock/automatic restart

With start interlock/automatic restart, the safety sensor remains in the OFF state when, following a power
supply interruption, the voltage supply is restored. After violation of the protective field, the system restarts
when the protective field is free again.

The start/restart interlock has two functions:
e Start interlock

¢ Automatic restart

Using start interlock/automatic restart

% In addition to the safety sensor you must also install the reset button. The machine operator starts the
machine with this reset button.

% Position the reset button outside the danger zone so that it cannot be activated from the protective
fields and danger zones. The operator must be able to see all danger zones from this position.

% Identify the area to be released on the reset button so that its meaning is clear and easy to understand.
% Ensure that nobody is in the danger zone before pressing the reset button.
% Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching outputs.

DANGER

Risk of death if start-up is operated unintentionally!

% Ensure that the reset button for unlocking the start interlock cannot be reached from the
danger zone.

% Before unlocking the start interlock, make certain that no people are in the danger zone.

Start interlock

The start interlock function prevents the machine from starting automatically after switching on or after the
supply voltage returns.

The machine only starts when you press the reset button.

Automatic restart
The automatic restart function starts the machine automatically as soon as the protective field is free again.
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5.6.3

5.7

Start/restart interlock (RES)

When accessing the protective field, the start/restart interlock ensures that the safety sensor remains in the
OFF state after the protective field has been cleared. It prevents automatic release of the safety circuits
and automatic start-up of the system, e.qg. if the protective field is again clear or if an interruption in the volt-
age supply is restored.

The start/restart interlock has two functions:
« Start interlock
* Restart interlock

For access guarding, the start/restart interlock function is mandatory. The protective device may
only be operated without start/restart interlock in certain exceptional cases and under certain
conditions acc. to ISO 12100.

Using start/restart interlock

% In addition to the safety sensor you must also install the reset button. The machine operator starts the
machine with this reset button.

% Position the reset button outside the danger zone so that it cannot be activated from the protective
fields and danger zones. The operator must be able to see all danger zones from this position.

% Identify the area to be released on the reset button so that its meaning is clear and easy to understand.
% Ensure that nobody is in the danger zone before pressing the reset button.
% Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching outputs.

Risk of death if start/restart is operated unintentionally!

% Ensure that the reset button for unlocking the start/restart interlock cannot be reached from
the danger zone.

% Before unlocking the start/restart interlock, make certain that no people are in the danger
zone.

Start interlock

The start interlock function prevents the machine from starting automatically after switching on or after the
supply voltage returns.

The machine only starts when you press the reset button.

Restart interlock

The restart interlock function prevents the machine from starting automatically, as soon as the protective
field is free again. The restart interlock function always includes the start interlock function.

The machine only starts again when you press the reset button.

Field pair changeover

The safety sensor has ten field pairs. Switchover between the field pairs is possible at all times, provided
the operating situation allows this.

Use the field pair changeover when the danger zones vary depending on the activity of the machine or the
operating state, e.g. driverless transportation system (DTSs), to control the field pair changeover for
straight and curved stretches.

If the rules for field pair changeover are not complied with, the safety sensor signals a fault and the safety-
related switching outputs are switched off.

The safety sensor has the following modes for field pair activation and field pair changeover:
* Fixed selection of one field pair
» Selection by signal inputs with the changeover mode Overlapped monitoring
» Selection by signal inputs with the changeover mode Fixed changeover moment
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5.71

5.7.2

Field pair activation and field pair changeover are configured via the protective function, e.g. CONFIGURA-
TION > Protective function A > MODE FOR FIELD PAIR ACTIVATION AND CHANGEOVER.

The field pair changeover can be monitored by means of configurable measures (see chapter 5.8 "Monitor-
ing of field pair changeover").

During the changeover process, the safety sensor monitors the field pair active before the field pair
changeover, according to the configured changeover mode and changeover time.

Using field pair changeover

You can configure and switch over the field pairs according to the different requirements. The field pairs are
changed over via the corresponding control inputs.

The rules for field pair changeover depend on the changeover mode and changeover time. The activated
field pair must correspond with the respective operating mode. The time of the field pair changeover must
correspond with the machine's risk assessment. You must take the lead time, braking distances, response
times and machine stopping times, e.g. influenced by overlapping protective fields, into account.

If the rules are not observed, the safety-related switching outputs switch off and a message is displayed
(see chapter 12 "Diagnostics and troubleshooting").

The following rules apply for the field pair changeover:

» The field pair changeover performed by the control system must agree with the safety sensor's configu-
ration. This configuration is specified with the configuration and diagnostics software (see chapter 9.4
"Configuring protective function").

» With field pair changeover to an occupied protective field, the safety sensor only switches off the
safety-related switching outputs after the set response time plus a synchronization time of 40 ms.

Take the lead time into consideration!
% Take the lead time of the changeover time and response time into consideration before op-

erating the machine in its new operating situation.

Fixed selection of one field pair

If Fixed selection of one field pair is set as the mode for field pair activation, field pair A1.1 is monitored
irrespective of how the control inputs are connected.

Changeover of five field pairs in changeover mode Overlapped monitoring

Changeover mode Overlapped monitoring: This changeover mode is only permitted for up to five field
pairs.

The field pair changeover must take place within a configurable time period of the changeover time. Two
field pairs can be monitored simultaneously during the changeover time.

 First the control unit must switch to a new field pair before it switches off the previously active one.
* A maximum of two field pairs are active.
Each field pair is then only active if it is selected by the control unit.

« The changeover time starts when the second field pair is connected. When the changeover time has
expired, only one field pair should still be active.

» The changeover time is specified with the configuration and diagnostics software (see chapter 9.4.4
"Creating and configuring protective/warning field pairs").
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5.7.3

Tab. 5.5: Connection of control inputs F1 to F5 with activation of field pairs A1.1 to A1.5 for protective function A
Field pair | Control input Description
F1 F2 F3 F4 F5

A1A1 1 0 0 0 0 Field pair A1.1 is active

A1.2 0 1 0 0 0 Field pair A1.2 is active

A1.3 0 0 1 0 0 Field pair A1.3 is active

A1.4 0 0 0 1 0 Field pair A1.4 is active

A1.5 0 0 0 0 1 Field pair A1.5 is active

In the case of two protective functions, connection of control inputs F6 to F10 applies analogously for acti-
vation of field pairs B1.1 to B1.5 for protective function B.

@ ® R

PF1.1 2 0 0
PF1.2 1 K o
PFA... 30 30 Q
PFAX 0 [ 1

@ §A1.2 x-x A1.2 & Al.x X|X A1.x§
1 Active protective field
2 An old protective field is active
3 Set changeover time
4 A new protective field is active
5 Changeover complete
PF Field pair or quad
XX Field pair changeover
Fig. 5.2: Signal/time diagram: Overlapped monitoring

Changeover of ten field pairs in changeover mode Fixed changeover moment

Changeover mode Fixed changeover moment: The field pair changeover must take place within the con-
figurable changeover time, i.e. after the changeover time has expired, a valid and stable input connection
must be present. The old field pair is monitored during the changeover time.

» The previously active field pair is monitored during the changeover time.

» The changeover time starts when the safety sensor registers a change at control inputs F1 to F5. When
the changeover time has expired, only one field pair should still be active.

* Monitoring of the newly activated field pair starts when the changeover time has expired.

» The changeover time is specified with the configuration and diagnostics software (see chapter 9.4.4
"Creating and configuring protective/warning field pairs").
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Tab. 5.6: Connection of control inputs F1 to F5 with activation of field pairs A1.1 to A1.10 for protective function A
Field pair | Control input Description

F1 F2 F3 F4 F5
A1A1 1 0 0 0 0 Field pair A1.1 is active
A1.2 0 1 0 0 0 Field pair A1.2 is active
A1.3 0 0 1 0 0 Field pair A1.3 is active
A1.4 0 0 0 1 0 Field pair A1.4 is active
A1.5 0 0 0 0 1 Field pair A1.5 is active
A1.6 1 1 1 1 0 Field pair A1.6 is active
A1.7 1 1 1 0 1 Field pair A1.7 is active
A1.8 1 1 0 1 1 Field pair A1.8 is active
A1.9 1 0 1 1 1 Field pair A1.9 is active
A1.10 0 1 1 1 1 Field pair A1.10 is active

In the case of two protective functions, connection of control inputs F6 to F10 applies analogously for acti-

vation of field pairs B1.1 to B1.10 for protective function B.

> ® T
PF1.1 0 1 0 1 0
PF1.2 |:o  EN— 0
PFA... 2 0 M Lo 0
PFAX 0  E— I ¢ o[ .
@ A1.2 @ A1.2 leX A1.x

1 Active protective field
2 An old protective field is active
3 Set changeover time
4 A new protective field is active
5

Initiation of the field pair changeover caused by a change in the signal — the old protective field is monitored

until the end of the changeover time

6 Fixed end — field pair changeover complete

7 ... Only one field pair change

PF Field pair or quad

XX Field pair changeover

Fig. 5.3: Signal/time diagram: Overlapped monitoring

5.8 Monitoring of field pair changeover

The Changeover order function determines the permissible field pair changeovers, e.qg. if field pair A1.3
must be changed over to field pair A2.5. If the Changeover order function is active, the safety-related

switching outputs (OSSDs) switch off in the following cases:
+ the control initiates an impermissible field pair changeover.

« the field pair to which the system is changed over has been deactivated.
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5.9

5.10

5.11

5.12

Activating the function

% The Changeover order is defined using the configuration and diagnostics software (see chapter 9.5
"Defining permissible field pair changeovers").

Reference contour monitoring

The reference contour monitoring function prevents unintentional misalignment and deliberate manipulation
of the safety sensor. If a protective field contains an area with reference contour, the safety sensor not only
monitors interruptions of the protective field, it also monitors the concurrence of the measured area contour
with the set reference contour. If the measurement values of the area contour deviate from the defined ref-
erence contour by more than the tolerance zone of 200 mm, i.e., if no object is detected in the area with
reference contour, the safety sensor switches off and the safety-related switching outputs (OSSDs) switch
to off.

Activation of the function

% Activate the Reference contour monitoring function together with the definition of the protective field
boundaries using the configuration and diagnostics software (see chapter 9.4.4 "Creating and configur-
ing protective/warning field pairs").

Field pair monitoring

The Field pair monitoring function is used to set the monitoring mode for the selected field pair.

The Standby request monitoring mode is used to switch off field pair monitoring and the safety-related
switching outputs (OSSDs). This is advisable when parking vehicles, for example.

Activation of the function

% Activate field pair monitoring in the configuration and diagnostics software (see chapter 9.4.5 "Configur-
ing field pair monitoring").

EDM contactor monitoring

The EDM contactor monitoring function dynamically monitors the contactors, relays or valves connected
downstream of the safety sensor. Prerequisite for this are switching elements with positive-guided feedback
contacts (normally closed contacts).

Activation of the function

% Activate the contactor monitoring function using the configuration and diagnostics software (see chap-
ter 9.4 "Configuring protective function").

If contactor monitoring is activated, it operates dynamically, i.e., in addition to monitoring the closed feed-
back circuit every time before the OSSDs are switched on, it also checks whether the feedback circuit has
opened within 500 ms after release and whether it has closed again within 500 ms after the OSSDs
switched off. If this is not the case, the OSSDs return to the OFF state after being switched on briefly.
A message is displayed on the alphanumerical display and the safety sensor switches to the fault interlock
state:

» With the OSSDs switched off, +24 V must be present at the EDM input.
+ With the OSSDs switched on, the EDM circuit must be open (high impedance).

E-Stop linkage
Through linkage, the behavior of the safety sensor can be controlled via a two-channel safety circuit.

The upstream safety devices and operational controls perform safety-relevant switch-off of the safety-re-
lated switching outputs of the safety sensor.

The following upstream sensors and operational controls are possible regarding the linkage:

« Safety device with two-channel contact-based switching output (normally closed contact), e.g. safety
switch, E-Stop rope switch, safety position switch and the like (see chapter 5.12.1 "Contact-based
safety circuit").

» Safety device with two-channel electronic OSSD switching output (see chapter 5.12.2 "Linkage of elec-
tronic safety-related switching outputs").
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5.12.1

5.12.2

5.13

E-Stop buttons connected to the safety sensor act only on the safety circuit to which the AOPD is assigned.
Thus, it can be considered to be an area E-Stop. The regulations for E-Stops apply to it, including those in
accordance with EN 60204-1 and EN ISO 13850, among others.

% In this case, observe the regulations for E-Stops.
If linkage is utilized, the response time of the linked device is extended by 20 ms.
% Take the extended response time into account when calculating the safety distance.

Contact-based safety circuit

This function switches off the safety-related switching outputs of the safety sensor by means of an up-
stream 2-channel contact-based safety circuit, e.g. by means of safety switches with separate actuators.

The safety sensor only switches on if the following conditions have been fulfilled:
* The protective field is free.
» The safety circuit is closed or both contacts have been closed simultaneously within 0.5 s.

Activation of the function

% Activate the linkage using the configuration and diagnostics software (see chapter 9.4.3 "Activating pro-
tective function and contactor monitoring").

Linkage of electronic safety-related switching outputs

This function is used to construct a serial connection of devices with electronic safety OSSD switching out-
puts. The OSSDs of an upstream safety device switch off the safety-related switching outputs of the safety
sensor as a central safety device. Regarding the downstream safety circuit, a linked system behaves like a
single device, i.e. only inputs are necessary in the downstream safety relay.

The following conditions have to be fulfilled for the OSSDs to switch on:
» The protective field must be free.

» The OSSDs of the upstream device must be switched on or have been switched on simultaneously
within 0.5 s.

contacts, can be switched in the safety circuit when linking electronic safety-related switching
outputs.

ﬂ A contact-based safety sensor, e.g. a safety switch with two positive-guided normally closed

% If this switch opens, it must close both circuits again simultaneously within a time tolerance
of 0.5 s. A message will otherwise be displayed on the safety sensor.

Activation of the function

% Activate the linkage using the configuration and diagnostics software (see chapter 9.4.3 "Activating pro-
tective function and contactor monitoring").

Signaling functions

The device and monitoring functions of the safety sensor deliver indication signals for the following function
groups:

* Protective functions, e.g.
» Protective field violated
» Warning field violated
 Field pair changeover active
 Device functions
* Error messages
« Warnings
» Diagnosis

The assignment of the individual functions within the function groups to the indication signals is defined us-
ing the configuration and diagnostics software (see chapter 9.6 "Configuring signal outputs").

For an overview of all logic and electrical signals of the safety sensor, see chapter 15.4 "Representation of
safety sensor status”.

Leuze electronic RSL 420 40



& Leuze electronic Applications

6.1

6.2

Applications

The following chapters essentially describe the safety sensor's usage possibilities.
» To safely mount the safety sensor for the respective application, see chapter 7 "Mounting".
» For the electrical connection of the safety sensor, see chapter 8 "Electrical connection”.

» To safely configure the safety sensor for the respective application, see chapter 9 "Configuring the
safety sensor".

Stationary danger zone guarding

Stationary danger zone guarding enables a very spacious protection of people on machines that are to re-
main as accessible as much as possible. The safety sensor is applied as a stop-activating and presence-
detecting protective device. The safety sensor's protective field is set up horizontally in front of the machine
or system's point of operation.

You can also use the stationary danger zone guarding if you do have to guard areas under the machine or
at the rear that are not visible.

If the danger zone changes during operation, the respective danger zone is guarded by means of a field
pair changeover while the working area is accessible.

1 Safety sensor
2 Danger zone, protective function activated
Fig. 6.1: Stationary danger zone guarding

Stationary point of operation guarding

Hand and arm protection are always required when people must work at the point of operation. The safety
sensor is applied as a stop-activating and presence-detecting protective device. The safety sensor's pro-
tective field is set up vertically in front of the machine or system's point of operation. In accordance with
EN ISO 13855, resolutions from 14 to 40 mm make sense here. This yields the necessary safety distance
for finger protection, among others (see chapter 7.3 "Stationary point of operation guarding").
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6.3 Stationary access guarding

Stationary access guarding protects people that step into a danger zone. The vertically aligned protective
field of the safety sensor detects the passage of a person. A side post and the floor serve as reference con-
tour for monitoring the position of the protective field. In contrast to danger zone guarding, the safety sen-
sor no longer registers a person in the danger zone after the passage. This is why the start/restart interlock
function is vital for access guarding.

1 Safety sensor

2 Reference contour

3 Danger zone 1, protective function activated

4 Danger zone 2, protective function deactivated
Fig. 6.2: Stationary access guarding
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6.4  Mobile danger zone guarding

Mobile danger zone guarding protects people that are located in the transportation path of a driverless
transportation system (DTS). The distance between the protective field front edge and the vehicle front
must be greater than the stopping distance of the vehicle with selected speed and maximum load. A safe
control system selects speed-dependent protective fields and can activate side horizontal protective fields
for curved stretches.

Warning field for forward travel

Protective field 1 for forward travel, deactivated
Protective field 2 for forward travel, activated
Protective field 1 for reverse travel, activated
Protective field 2 for reverse travel, deactivated
Warning field for reverse travel

D a b~ ON -

Fig. 6.3: Mobile danger zone guarding
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Warning field for forward travel

Protective field 1 for forward travel, deactivated
Protective field 2 for forward travel, activated
Protective field 1 for reverse travel, activated
Protective field 2 for reverse travel, deactivated
Warning field for reverse travel

1
2
3
4
5
6

Fig. 6.4: Mobile danger zone guarding
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6.5

Danger zone safeguarding on side-tracking skates

Side-tracking skate guarding

Side-tracking skate guarding protects personnel who are located in the transportation path of a transverse
side-tracking skate (TSS). One safety sensor is mounted in each direction of travel. The safety sensor that
is mounted opposite the current direction of travel is deactivated. Evaluation of the warning field allows the
transverse side-tracking skate to be braked gently. To ensure optimum material transport, the control
changes over the protective/warning field pair depending on the state and speed.

Mobile side guarding

Mobile side guarding protects people and objects that are located on the vehicles path. This application is
used when very low arranged roller conveyors do not permit an unobstructed passage of horizontal, lateral
protrude protective fields. The safety sensors are positioned laterally and the protective fields are arranged
vertically, at a slight tilt. The position of the front edges of the side protective fields is oriented here on the
position of the front edge of the horizontal protective field.

1 Protective and warning field pair for forward travel, activated

2 Protective and warning field pair for side guarding, left, activated
3 Protective and warning field pair for side guarding, right, activated
4 Protective and warning field pair for reverse travel, deactivated
Fig. 6.5: Mobile side guarding on side-tracking skates
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6.6  Vehicle navigation

This function is only available with RSL 425 devices.

The measurement data cyclically transmitted by the safety sensor can be used for navigation by driverless

transportation systems.
For each measurement point of the scan level, values for distance and signal strength are part of the mea-
surement data. A navigation system evaluates the measurement data and calculates the position of the ve-
hicle. With the help of the transmitted signal strength, highly reflective landmarks can be detected.

1 Safety sensor
2 Retro-reflector

Fig. 6.6: Vehicle navigation

In addition to the measurement data, a status profile of the safety sensor is also transmitted. The status
profile contains information about the status of the inputs and outputs as well as other status information.
The status profile thereby offers a possibility for performing diagnostics on the safety sensor.

You can find additional information in document RSL400 UDP specification, which is available for download
on the Leuze electronic website: www.leuze.com

6.6.1 Signal strength and reflector detection

This function is only available with RSL 425 devices.

The signal strength transmitted via UDP is a measure of the the optical power received by the safety sen-
sor, which is largely dependent on the following values:
» Distance
» Brightness of the object or structure of the object surface
» Angle of incidence of the laser beam on the object surface
0°: vertically incident light

» Share of area of the light spot on the object
100%: the light spot lies completely on the measured object
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The signal strength transmitted by the safety sensor can be used to navigate automated guided vehicles.
The transmitted signal strength value is a unitless, non-calibrated measurement value that is output unpro-
cessed by the safety sensor.

To navigate automated guided vehicles, highly reflective landmarks are distinguished from the less-reflec-
tive surroundings. These landmarks usually consist of retro-reflector films.

Retro-reflectors can be identified by analyzing the signal strength values. If the signal strength exceeds a
limit value, a retro-reflector can be mapped at this angle. Reliable detection of retro-reflectors is normally
possible with a signal strength limit value of 180 or higher at a distance > 0.6 m.

For reflective surfaces, the safety sensor usually measures a signal strength value of maximum 500. Signal
strength values > 500 can be caused by object edge effects and do not normally correspond to any real ob-
ject diffuse reflection.

Due to the narrow light spot of the RSL400, object edge effects rarely occur. Object edge effects can be
caused if a light beam is incident on multiple objects at different distances.

300
.'I" sanmnmnen -.-..""'ltch..u-l-l.-l
250 - ..'.'-"""""l!lltunu
.: LT ---...@
200 §
150
100 ______@
501
D I 1 1 1 I@
0,6 5 10 15 20 25
1 Object distance [m]
2 Signal strength
3 Retro-reflector film
4 White surface
Fig. 6.7: Signal strength curves depending on the distance

The figure shows a typical curve of the signal strength transmitted by the safety sensor as a function of the
measured object distance and object diffuse reflection for the following boundary conditions:

» Angle of incidence of the laser beam: 0°
» Share of area of the light spot on the object: 100%

The upper curve (3) represents the typical, distance-dependent change of the signal strength for a typical
retro-reflector film, e.g., 3M™ Diamond Grade 983-10™.

The lower curve (4) shows the typical, distance-dependent change of the signal strength for a white, natu-
rally scattering surface with 90% diffuse reflection, e.g., a white wall.
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71

Mounting

The safety sensor's protective function is only guaranteed when the device arrangement, configuration,
protective field dimensioning and mounting are coordinated with the respective application.

The installation work must only be performed by a competent person in compliance with the applicable
standards and these instructions. The mounting must be thoroughly inspected on completion.

% You must observe and comply with the respective relevant machine-specific standards and regulations
(see chapter 16 "Standards and legal regulations").

% Observe the basic information on mounting (see chapter 7.1 "Basic infos").

Improper mounting may result in serious injury!

The protective function of the safety sensor is only ensured if appropriately and professionally
mounted for the respective, intended area of application.

% Only allow competent persons to install the safety sensor.

% Maintain the necessary safety distances (see chapter 7.1.1 "Calculation of safety dis-
tance S").

% Make sure that stepping behind, crawling under or stepping over the protective device is reli-
ably ruled out and reaching under, over or around is taken into account in the safety dis-
tance, if applicable with additional distance Cgq corresponding to EN ISO 13855.

% Take measures to prevent that the safety sensor can be used to gain access to the danger
zone, e.g. by stepping or climbing into it.

% Observe the relevant standards, regulations and these instructions.
& After mounting, check the safety sensor for proper function.

% Clean the safety sensor at regular intervals.
Environmental conditions: see chapter 15 "Technical data"
Care: see chapter 13 "Care, maintenance and disposal"

Basic infos

Calculation of safety distance S

Optical protective devices can only perform their protective function if they are mounted with adequate
safety distance. When mounting, all delay times must be taken into account, such as the response times of
the safety sensor and control elements as well as the stopping time of the machine, among others.

The following standards specify calculation formulas:

+ ENISO 13855, "Safety of machines - The positioning of protective device in respect of approach
speeds of parts of the human body": mounting situation and safety distances.

General formula for calculating the safety distance S of an Optoelectronic Protective Device acc. to
EN ISO 13855

S=K-T+C
S [mm] = Safety distance
K [mm/s] = Approach speed
T [s] = Total time of the delay, sum from (t, + t; + t,))
t, [s] = Response time of the protective device
t; [s] = Response time of the safety relay
tn [s] = Stopping time of the machine
C [mm] = Additional distance to the safety distance

If longer stopping times are determined during regular inspections, an appropriate additional
time must be added to t,,..
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7.1.2 Suitable mounting locations
Area of application: mounting
Tester: Technician who mounts the safety sensor

Tab. 7.1: Checklist for mounting preparations

Check: Yes No

Is the safety distance to the hazard location maintained?

Has the scanning angle of the safety sensor as given on the marking/template on
the top of the sensor been taken into consideration?

Can the point of operation or the danger zone only be accessed through the pro-
tective field?

Have measures been taken to prevent the protective field from being bypassed by
crawling under?

Is stepping behind the protective device prevented or is mechanical protection
available?

Can the safety sensors be fastened in such a way that they cannot be moved and
turned?

Is the safety sensor accessible for testing and replacing?

Is it impossible to actuate the reset button from within the danger zone?

Can the entire danger zone be seen from the installation site of the reset button?

If you answer one of the items on the checklist with no, the mounting location must be changed.

7.1.3 Mounting the safety sensor

Detailed information on mounting the safety sensor can be found in the document "Quick Start
Guide RSL 400".

Proceed as follows:

% Calculate the necessary safety distance and determine the required additional distances for your appli-
cation.

% Determine the mounting location.

* Observe the information regarding the mounting locations; see chapter 7.1.2 "Suitable mounting loca-
tions"

» Ensure that machine parts, safety guards or covers do not impair the safety sensor's field of vision.

* Make sure that the scanning range of the safety sensor is not limited. To mount the safety sensor tak-
ing the scanning range into consideration, a template must be attached to the top cover of the safety
sensor.
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all dimensions in mm

Safety sensor

Template (markings on safety sensor)

Mounting location

Reference point for distance measurement and protective field radius
Area with unobstructed view; must remain free
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Fig. 7.1: Mounting taking the scanning range of 270° into consideration
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all dimensions in mm

1 Scan level
2 Area with unobstructed view; must remain free (40 mm)
Fig. 7.2: Mounting: area with unobstructed view

% Determine whether you are going to install the safety sensor with or without the mounting system.
During mounting, use the four supplied M5 screws or four similar screws with a diameter of 5 mm, and
make certain that the mounting elements or mounting construction supports at least four times the
weight of the device with or without mounting system.

% Have the appropriate tools at the ready and mount the safety sensor.
% Install protective enclosures or safety bars if the safety sensor is in an exposed position.

% If there is a risk that the safety sensor will be used as a climbing aid, install a suitable physical cover
over the safety sensor.
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% Align the mounted safety sensor horizontally and vertically using the integrated electronic spirit level.
 For the electronic spirit level to work, the supply voltage of 24 V must be present at the safety sensor.

» The electronic spirit level indicates the vertical (V) and horizontal (H) alignment of the safety sensor.
The spirit level is displayed

« permanently after the end of the booting phase/start phase when starting without configuration
» repeatedly until the end of the booting phase/start phase when starting with configuration

+ using the configuration and diagnostic software:
Diagnosis > [Align sensor mechanically] button (=)

» When mounting without a mounting system, the safety sensor can be aligned only slightly along the
horizontal axis.

% Attach safety notice stickers to the mounted safety sensor (the stickers are included in the delivery con-
tents).

% Configure the safety sensor with the configuration and diagnostics software; see chapter 9 "Configuring
the safety sensor™:

» Observe the information on the response times, the stopping time of the machine and the protective
field dimensioning for your application.

« Determine the size of the protective field on the basis of the mounting location, the calculated safety
distances and additional distances.

Protective fields with a radius of less than 200 mm (safety sensor short range) are not permitted
and are therefore preset as minimum contour.

» Configure the protective field so that the safety-related switching outputs are switched off from every
accessible point with sufficient minimum distance D.

» Determine the start-up/restart operating mode required for the application.
« If you are using start and/or restart interlock, determine the position for the reset button.

* Many safety-relevant parameters are preset for each application in the configuration and diagnostics
software. Use these preset values where possible.

» Determine the conditions for the field pair changeover and the sequence of the field pair changeover.
% Create a record document for the device configuration and protective field dimensioning.

» The document must be signed by the person responsible for the configuration.

* Include this document with the machine documentation.

% Mark the protective field boundaries on the floor.
You can easily test the safety sensor along this marking.

After mounting, you can electrically connect (see chapter 8 "Electrical connection"), start up, align (see
chapter 10 "Starting up the device"), and test (see chapter 11 "Testing") the safety sensor.
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7.1.4 Mounting examples

54,6

all dimensions in mm

1 Safety sensor
2 Column
3 BT856M mounting bracket
Fig. 7.3: Example: mounting on a post
40
T / h NG

Yy N
BN

40

all dimensions in mm

1 Safety sensor
2 BT840M mounting bracket
Fig. 7.4: Example: mounting on a chamfered corner
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1 BTF815M mounting bracket (only in combination with the BTU800M mounting system)
2 BTU800M mounting system

3 Safety sensor

Fig. 7.5: Example: mounting on floor

7.1.5 Information on protective field dimensioning

Protective fields with a radius of less than 200 mm (safety sensor short range) are not permitted
and are therefore preset as minimum contour.

% Dimension the protective field big enough that the safety sensor's switching signal can stop the danger-
ous movement in good time.
If several protective fields are selected with field pair changeover, this condition applies for all protec-

tive fields.
Protective fields with a radius of less than 200 mm (safety sensor short range) are not permitted and
are therefore preset as minimum contour.

% If you cannot sufficiently dimension a protective field, use additional protective measures, e.g. safety
guards.

% Ensure that the protective field cannot be walked behind in the direction of the danger zone.

% Observe all delay times, e.g. safety sensor response times, control element response times, braking
times or machine or driverless transportation system stopping times (DTS).

% Take changed delay times, which, for example, can be caused by reducing the braking force, into ac-
count.

% Observe shadowing effects, e.g. surfaces and areas behind static objects. People in the shadows of
these objects will not be detected by the safety sensor.

% Observe the lateral tolerance when dimensioning the protective fields (see chapter 15 "Technical
data").

% Do not use cone-shaped protective field contours, as these do not guarantee any protective function.
% Take the additional distances required for the application into account.

Handling unmonitored areas

There is an area behind the safety sensor that the safety sensor does not monitor. Unmonitored areas can
also materialize, e.g. if you install a safety sensor on a rounded off vehicle front.

It must not be possible to walk behind unmonitored areas.
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1 Safety sensor
2 Protective field
3 Unmonitored area;

Optimum availability at a distance of 50 mm to fixed contours

Fig. 7.6: Unmonitored area
% Prevent access to an unmonitored area with screens.
% Prevent walking behind by countersinking the safety sensor into the machine contour.

Countersinking into the machine contour, min. 100 mm
Minimum distance above the scanner unit, min. 34 mm
Protective field

Safety sensor

Machine

Angled physical cover

D a b~ ON -

Fig. 7.7: Stepping behind protection by countersinking into the machine contour

% Use a physical cover set at an angle over the safety sensor if you expect that the safety sensor will be
used as a climbing aid or standing surface.
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Protective field setup with adjacent safety sensors

The safety sensor has been developed in a way that prevents several safety sensors from interfering with
one another as much as possible. Nevertheless, if several safety sensors are positioned adjacent to each
other, this may result in a reduction in the availability of the safety sensors.

% When mounting the safety sensor, avoid glossy surfaces directly behind the optics cover.

% Plan for shielding with stationary applications.
The shielding must be at least as high as the safety sensor's optics cover and embedded with the front
housing edge.
If you plan for a shielding that is still within the countersinking in the machine contour, the resolution of
the protective fields must not be impaired at any accessible points.
You require the reciprocal shielding with both horizontal and vertical alignment of the protective fields.

1 Point of operation

2 Safety sensor

3 Machine with countersinking for sensor installation
4 Protective fields

5 Shielding

Fig. 7.8: Shielding prevents reciprocal influencing of safety sensors set up beside one another

% Install the safety sensors off-set on the height.

1 Minimum distance, min. 100 mm
2 Scan level
Fig. 7.9: Height offset mounting, parallel alignment
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7.2

% Install the safety sensors with crossed alignment.

Scan level

Fig. 7.10: Mounting beside one another, without height offset, crossed alignment

1 Scan level

Fig. 7.11: Mutually opposing mounting, without height offset, crossed alignment

Stationary danger zone guarding
The safety sensor takes over the stop-activating and presence-detecting function.

Calculation of safety distance S for parallel approach to the protective field

S=K.-T+C
Sro [mm] = Safety distance
K [mm/s] = Approach speed for danger zone guarding with approach direction parallel to the protective
field (resolution up to 90 mm): 1600 mm/s
T [s] = Total time of the delay, sum from (t, + t; + t)
t, [s] = Response time of the protective device
t [s] = Response time of the safety relay
t, [s] = Stopping time of the machine
C [mm] Additional distance for danger zone guarding with approach reaction

H = height of the protective field, H,,, = minimum installation height permitted, but no smaller
than 0, d = resolution of the protective device C = 1200 mm - 0.4 x H; H_;, = 15 x (d - 50)

Response times, stopping time of the machine

The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. At least two
consecutive scans must be interrupted so that the safety-related switching outputs switch off. The safety
sensor's minimum response time is therefore 80 ms.

If you want to increase the safety sensor's availability in an environment with fine particles, increase the
number of interrupted scans after which the safety-related switching outputs switch off. With each addi-
tional scan the response time t, increases by 40 ms. With K = 1600 mm/s the safety distance increases by
64 mm per additional scan.

% Select a response time t, of at least 120 ms or higher.

% Determine the machine/system's stopping time t,,.
If data is not available, you can commission Leuze electronic to perform measurements; see chapter 14

"Service and support".

% If an increase in the stopping time within the regular test periods is to be expected, take an additional
time into account for the machine's stopping time t,..
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Additional distance C for danger zone guarding with approach reaction
You prevent reaching the point of operation by reaching over with the additional distance C:

C =1200-0,4-H

H [mm] = Height of protective field above floor (installation height)
Cuin [mm] =850 mm
Huax  [mm] = 1000 mm

The minimum permissible installation height depends on the resolution of the safety sensor:

Tab. 7.2: Additional distance C depending on the resolution of the safety sensor
50 0 1200
60 150 1140
70 300 1080

Application-related additional distances for safety distance S

The protective field boundaries must be defined so that the calculated safety distance S to the point of op-
eration, extended by the additional distances, is complied with everywhere. Where this is not possible or
does not make sense, you can use hard guards as supplementary measures.

Routing machine with free space for sensor protective field in the area under the machine table
Safety sensor

Protective field contour

Warning field contour

Calculated safety distance S

Minimum distance D (= safety distance S + additional distance Zg, + Zggr,, Where required)

R¢ Largest protective field radius without additional distances, measured from the rotation axis of the rotary
mirror

On b~ wN

Fig. 7.12: Defining the protective field contour for a stationary, horizontal protective field
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% Define the limits of the protective field using the safety distance S without an additional distance.

% Determine the biggest protective field radius R for this protective field.
The biggest protective field radius determines the additional distance Zg,, for the system-related mea-
surement error, by which the protective field contour must be enlarged.
The position of the rotary mirror's center point with regard to the housing is provided by the dimen-
sioned drawings.

Tab. 7.3: Additional distance Zg,, for the protective field contour because of measurement error

Biggest protective field radius R; without additional distances Additional dis-
tance Zg,

<6.25m 100 mm

>6.25m 120 mm

% Avoid retro-reflectors at the beam level beyond the protective field boundaries. If this is not possible,
add another additional distance Zggr of 100 mm.

Minimum distance D to the protective field contour
The minimum distance D is the distance between point of operation and protective field contour.

D = S+ZSM+ZREFL

D [mm] = Minimum distance between the point of operation and the protective field contour
Zsu [mm] = Additional distance for system-related measurement error
Zeeer  [mm] = Additional distance for retro-reflectors

% If the protective field runs up against fixed boundaries, such as walls or machine frames, take a coun-
tersinking into the machine contour of at least the size of the necessary additional distance Z,,, and
Zrer. Where required, into account. With the protective field contour under these conditions, stay about
50 mm away from the machine surface.

% If the protective field runs up against hard guards, ensure that the protective field ends under instead of
in front of the hard guards. The width of the lower post must correspond with the size of the required
additional distances.

% If all hazards in the fenced off area are covered by the safety sensor and the height of the beam level is
300 mm, you can raise the bottom edge of the hard guards from 200 mm to 350 mm in the protective
field range. The protective field reaching to under the hard guards takes over the protective function of
preventing an adult from crawling under in this case.

The beam level of the safety sensor is level with the alphanumerical display.

% Prevent obstructions within the calculated protective field boundaries. If this is not possible, implement
protective measures so that the point of operation cannot be reached from out of the shadow of the ob-
struction.
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7.3

Stationary point of operation guarding
The safety sensor takes over the stop-activating and presence-detecting function.
Calculation of safety distance S, for access over the vertical protective field

Sro = K- T+Cgro

Sro [mm] = Safety distance

K [mm/s] = Approach speed for point of operation guarding with approach reaction and normal approach
direction to the protective field (resolution 14 to 40 mm): 2000 mm/s or 1600 mm/s, when
Sko > 500 mm

[s] = Total time of the delay, sum from (t, + t, + t.))

t, [s] = Response time of the protective device

t; [s] = Response time of the safety relay

tn [s] = Stopping time of the machine

Cro [mm] = Additional distance in which a body part can move towards the protective device before the

protective device triggers

Response times, stopping time of the machine

The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. With each
additional scan the response time t, increases by 40 ms. With K = 2000 mm/s approach speed this corre-
sponds with an increase in the safety distance of 80 mm per additional scan. With K = 1600 mm/s it is

64 mm.

% Select a response time t, of at least 80 ms or higher.

% Determine the machine/system's stopping time t,,.
If data is not available, you can commission Leuze electronic to perform measurements (see chapter
14 "Service and support").

% If an increase in the stopping time within the regular test periods is to be expected, take an additional
time into account for the machine's stopping time t,,.
Additional distance Cg, for finger protection

The required finger protection is ensured here by an additional distance C, which depends on the safety
sensor resolution, in addition to the safety distance.

 Detection of an adult's hand:

* Resolution: 30 mm

» Additional distance Cggo: 128 mm
* Arm detection:

* Resolution: 40 mm

» Additional distance Cgg: 208 mm

Protective field contour and reference contour

With a vertical protective field, you must define at least two sides of the protective field contour as refer-
ence contour. The objective is to monitor the position of the protective field with regard to its marginal area.
If the arrangement misaligns and the distance of the safety sensor to the reference surface changes as a
result, switch the safety-related switching outputs off.
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Physical frame for reference contour

Reference contour, must cover at least two sides of the protective field

Safety sensor

Distance e between the reference contour frame and machine opening, recommended: € = 150 mm
Machine opening contour

a B~ WON -

Fig. 7.13: Defining the protective field contour and reference contour, stationary point of operation guarding, verti-
cal protective field

7.4 Stationary access guarding

The vertical protective field used for access guarding only detects people during passage through. After a
person has passed through, a start/restart interlock must ensure that the dangerous movement does not
start again automatically.

Sgpr = K-T+Cgxt

Sgr [mm] = Safety distance

K [mm/s] = Approach speed for access guarding with approach direction orthogonal to the protective
field: 2000 mm/s or 1600 mm/s, when Sg; > 500 mm

T [s] = Total time of the delay, sum from (t, + t, + t.))

t, [s] = Response time of the protective device, max. 80 ms

t; [s] = Response time of the safety relay

tn [s] = Stopping time of the machine

Cxr [mm] = Additional distance for access guarding with approach reaction with resolutions of

14 to 40 mm, d = resolution of protective device Cg; = 8 x (d - 14) mm. Additional distance for
access guarding for resolutions > 40 mm: Cg; = 850 mm (standard value for arm length)

Response times, stopping time of the machine

The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. With each ad-
ditional scan the response time t, increases by 40 ms. With K = 2000 mm/s approach speed this corresponds

with an increase in the safety distance of 80 mm per additional scan. With K = 1600 mm/s it is 64 mm.

% Select a response time t, of 80 ms or higher.
Never define a value higher than 80 ms for t, for access guarding or passage controls. With higher val
ues it can happen that a person might not be detected when passing through the protective field with
an approach speed of 1600 mm/s.

% Determine the machine/system's stopping time t,,.
If data is not available, you can commission Leuze electronic to perform measurements (see chapter
14 "Service and support").

% If an increase in the stopping time within the regular test periods is to be expected, take an additional
time into account for the machine's stopping time t,,.
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Additional distance Cg; for finger protection

The required finger protection is ensured here by an additional distance C, which depends on the safety
sensor resolution, in addition to the safety distance.

 Detection of an adult's hand:

* Resolution: 30 mm

» Additional distance Cgr: 128 mm
* Arm detection:

* Resolution: 40 mm

» Additional distance Cgr: 208 mm

Protective field contour and reference contour

With a vertical protective field, you must define at least two sides of the protective field contour as refer-
ence contour. The objective is to monitor the position of the protective field with regard to its marginal area.
If the arrangement misaligns and the distance of the safety sensor to the reference surface changes as a
result, switch the safety-related switching outputs off.

% When defining the protective field ensure that there are no gaps bigger than 150 mm.

% When defining the protective field boundaries, specify the sectors that monitor the position of the pro-
tective field as reference contour.

7.5 Mobile danger zone guarding on DTSs

Danger zone guarding protects people and objects that are in rooms in which vehicles move in, e.g. auto-
mated guided vehicle systems (DTSs).

A horizontally arranged protective field protects people and objects that are in the vehicle's path and are
detected by the front edge of the protective field.

Danger of injury because of insufficient vehicle stopping distance

% The operator of the machine must use organizing measures to prevent people from entering
the protective field of the vehicle from the sides or being able to move towards an approach-

ing vehicle.

% Only use the safety sensor on vehicles with electrical drive and electrically influenced drive and braking
devices.

% Only install the safety sensor on the front of the vehicle.
If you must also guard the reverse travel, you must also install a safety sensor on the rear of the vehi-
cle.

% Mount the safety sensor on the vehicle so that there are no unmonitored areas = 70 mm between the
protective field and vehicle front.

% Set the mounting height such that the beam level is not more than 200 mm above the floor.
A person lying on the floor can therefore be safely detected. This is required by the C standard,
EN 1525 "Safety of industrial trucks — Driverless corridor supply vehicles and their systems".

The beam level of the safety sensor is level with the alphanumerical display.
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7.5.1 Minimum distance D

D = Da+Zges
D [mm] = Minimum distance, vehicle front (danger) to protective field front edge
D, [mm] = Stopping distance
Ziot [mm] = Sum of required additional distances

200
I
D
A
GES]|
D
Fig. 7.14: Mobile danger zone guarding, calculation of required minimum distance D
Stopping distance D,
Dp = Viax (Ty+Ty)+Dg- Ly Ly
D, [mm] = Stopping distance
Vinax [mm/s] = Maximum vehicle speed
T, [s] = Response time of the safety sensor
T, [s] = Response time of the FTS
Dg [mm] = Braking distance with v,,,, and maximum vehicle load
L, [---] = Factor for brake wear
L, [--] = -Factor for problematic floor conditions, e.g. dirt, wet conditions
Additional distances Z
Zges = Zsm+ Zp + ZReFL
Zi [mm] = Total of the required additional distances
Zsm [mm] = Additional distance for system-related measurement error, see chapter 7.2 "Stationary dan-
ger zone guarding"
Ze [mm] = Additional distance required with lack of floor space H;
Zeere  [mm] = Additional distance required with retro-reflectors beyond the protective field boundaries;

Zger, = 100 mm

The additional distance Z,, is always required. Its size depends on the biggest radius Rg from the safety
sensor mirror's rotary axis to the protective field boundary without Z;,. The position of the rotary mirror axis
depends on the installation situation.
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7.5.2

The additional distance Z. is required if the vehicle does not have enough free floor space Hr and there is
therefore no space under the vehicle or the safety sensor for the tips of the feet. You determine the addi-
tional distance Z: according to the following diagram:

H

F

120
100 ™~
80
60
40
20

F

20 40 60 80 100120 140 160

Fig. 7.15: Diagram for determining the additional distance Z: with lack of floor space H:
If wheels are mounted near the side wall, always add an additional distance Z > 150 mm.

Protective field dimensions

i
O]
N
D ZGES__

D
D Minimum distance, vehicle front (danger) to protective field front edge
Da Stopping distance
Zror Total required additional distances to the front and for both sides
Fo Distance from safety sensor center to left vehicle edge
Fr Distance from safety sensor center to right vehicle edge
Rg Biggest radius in the protective field without Z;o; for determining the additional distance Zg),
Fig. 7.16: Mobile danger zone guarding, dimensions for horizontal protective field

% Select 70 mm resolution.

% Set the protective field length so that the response time until braking and the braking distance, including
factors for wear and tear and floor conditions, and any necessary additional distances are taken into
account.

% Arrange the protective field symmetrically with reference to the vehicle width, even if the safety sensor
is not arranged centered.

% Configure an upstream warning field that reduces the vehicle's speed.
A full brake with a subsequent interruption of the protective field is then executed moderately and is
less demanding on the vehicle's drives.
Dimension the minimum distance D for the maximum speed as if the speed reduction initiated by the
warning field had not happened.
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% Take the required free space for lateral protrude protective fields under the roller conveyors along the
transportation path into account.

% If you have to expect angular deviations of the vehicle during the travel, plan an additional tolerance
area to guarantee undisturbed travel operation.

7.6 Mobile side guarding on DTSs

Danger of injury because of insufficient vehicle stopping distance
A % The operator of the machine must use organizing measures to ensure that people cannot

enter the vehicle's protective field from the side.

% For mobile vertical protective fields use a resolution of at least 150 mm.

% Position the protective field edges in the travel direction in accordance with the front protective field
edge of the horizontal protective field.

% Ensure that the response times of all components of the switch-off circuit are the same or balance the
response times with different protective field dimensioning.

& Set the vertical protective fields at a slight angle so that the lower protective field edges protrude over
the vehicle width by the amount of the additional distances, Zg,, Z- and Zgcr, Where required; see chap-
ter 7.5.2 "Protective field dimensions".

7.7 Mounting accessories
7.71  Mounting system

Using the mounting system you can adjust the safety sensor horizontally and vertically by +10 degrees
when mounting.

Fig. 7.17: BTU800OM mounting system

Floor mounting only with mounting system BTU800M

% The mounting system BTU800M must be used in the case of installation using the mounting
bracket for floor mounting.

% Install the wall mount or mounting bracket for floor mounting on the system side.
% Mount the mounting system on the wall mount or on the mounting bracket for floor mounting.

& Attach the safety sensor to the mounting system.
Tightening the screws fixes the safety sensor in position.

% Align the safety sensor using the integrated electronic spirit level.
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7.7.2 Loop guard

The loop guard for the optics cover prevents damage to the safety sensor caused by light contact with for-
eign objects.

The loop guard can only be used together with the mounting system BTU8S00M.

BTF815M mounting bracket for floor mounting (only with BTU800M mounting system)
BTU800M mounting system

Loop guard

Safety sensor

O I S R

Fig. 7.18: Loop guard
& Attach the safety sensor to the mounting system.
% Engage the loop guard for the optics cover from above into the mounting system.
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8 Electrical connection

Faulty electrical connection or improper function selection may result in serious injury!
% Only allow competent persons to perform the electrical connection.

% For access guarding, activate the start/restart interlock and make certain that it cannot be
unlocked from within the danger zone.

% Select the functions so that the safety sensor can be used as intended (see chapter 2.1 "In-
tended use").
% Select the safety-relevant functions for the safety sensor (see chapter 5.2 "Function modes
of safety sensor").

% Always loop both safety-related switching outputs OSSD1 and OSSD?2 into the work circuit
of the machine.

% Signal outputs must not be used for switching safety-relevant signals.

NOTICE

Laying cables!
% Lay all connection cables and signal lines within the electrical installation space or perma-
nently in cable ducts.
% Lay the cables and lines so that they are protected against external damages.

% For further information: see EN ISO 13849-2, Table D.4.

NOTICE

Observe the maximum cable length!
Observe the maximum cable lengths as a function of operating voltage and load current (see

chapter 8.3 "Connection unit CU416").

NOTICE
Observe when wiring with terminals and connectors!

In the case of wiring that continues beyond the device or during repairs to connectors, the user
must ensure that cables or conductors that have defectively disconnected cannot result in con-

tact with other signals.
% Use suitable terminals.
% Use heat-shrink tubing, wire-end sleeves or similar.

8.1 Electrical supply
see chapter 15.1 "General specifications”.

Functional earth

NOTICE
0 Always connect the housing of the safety sensor to functional earth or ground!

% The housing of the safety sensor must always be connected to earth (functional earth) or
machine/vehicle ground.

% If the safety sensor is attached to a non-conductive material (e.g. a concrete wall), the hous-
ing of the safety sensor must be earthed.

» Factory recommendation: Functional earth via a ground strap/braid (low impedance for RF).
Connection points for self-tapping screws used for the ground connection are provided and labeled on
the bottom of the connection unit (see chapter 8.3 "Connection unit CU416").
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8.2

8.21

» Functional grounding via the shield of the connection cable.
For grounding, the shield of the connection cable in the switch cabinet must be connected to earth or
machine/vehicle ground.

Make sure that potential equalization is provided!
% If the housing of the safety sensor or the mounting bracket — despite being mounted on a
non-conductive material — is connected to metallic parts (even temporarily), you must ensure

that the appropriate potential equalization is provided between the switch cabinet and hous-
ing potential; e.g. by grounding the Ethernet connection.

Interfaces

The safety sensor has two interfaces:
* Interface for connection with the control system
* Interface for communication with PC or laptop

Tab. 8.1: Interfaces
Interface Type Function
Control Connection cable, 16-wire » Power supply
» Switching lines and signal lines
Communication |M12 —RJ 45 Configuration interface and data interface:

» Parameter configuration

» Protective field definition and warning field definition

» Data transmission and measurement value transmis-
sion

» Diagnosis

The control cable is permanently attached to the connection unit. A protection cap on the connection unit
protects the communication interface when no PC is connected.

Connection cable, control
The safety sensor is equipped with a 16-wire connection cable.

Tab. 8.2: Connection cable, control
Core color Signal Description
White RES1 Start/restart input, protective function A
Acknowledgment
Brown 24V Supply voltage
Green EA1 Contactor monitoring OSSD A
State signaling, configurable
Yellow A1 Output signal
State signaling, configurable
Gray OSSDA1 Safety-related switching output, protective function A
Pink OSSDA2 Safety-related switching output, protective function A
Blue 0V (GND) Supply voltage ground
Red MELD Output signal
State signaling, configurable
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Core color Signal Description
Black F1 5 function inputs for field pair changeover, protective function A
Violet F2
Gray/pink F3
Red/blue F4
White/Green F5
Brown/Green SE1 Linkage input (E-Stop, OSSD - external device)
White/Yellow SE2 Linkage input (E-Stop, OSSD — external device)
Yellow/Brown A2 Output signal
State signaling, configurable

Connection cable with M30 connector

The safety sensor is equipped with a 16-pin M30 connector.

Fig. 8.1: Pin assignment for M30 connector, 16-pin
Tab. 8.3: Pin assignment
Pin Core color Signal Description
1 White RES1 Start/restart input
protective function A
acknowledgment
2 Brown 24V Supply voltage
Green EA1 Contactor monitoring OSSD A
Alternatively: State signaling, configurable
4 Yellow A1 Output signal
state signaling, configurable
5 Gray OSSDA1 Safety-related switching output
protective function A
6 Pink OSSDA2 Safety-related switching output
protective function A
Blue 0V (GND) Supply voltage ground
8 Red MELD Output signal

State signaling, configurable
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8.2.3

Pin Core color Signal Description
9 Black F1 5 function inputs for field pair changeover
10 Violet F2 protective function A
X Field pair changeover with 100 field pairs (A1.x) —
11 Gray/pink F3 2nd position
12 Red/blue F4 Field pair changeover with multi configuration (A1.x)
13 White/Green F5 within one bank
14 Brown/Green SE1 Linkage input
(E-Stop, OSSD - external device)
15 White/Yellow SE2 Linkage input
(E-Stop, OSSD - external device)
16 Yellow/Brown A2 Output signal
state signaling, configurable
Connector Shield FE Functional earth, connection cable shield
housing

Pin assignment of M12 Ethernet interface (communication) ( D-coded)
The safety sensor is equipped with a 4-pin M12 connector.

3 4

Fig. 8.2: Pin assignment of the Ethernet interface
Tab. 8.4: Pin assignment of the Ethernet interface
PIN Signal Description
1 TD+ Data communication, transmission
RD+ Data communication, transmission
TD- Data communication, reception
RD- Data communication, reception
FE GND/shield Functional earth, communication cable shield. The shield of the inter-
connection cable is on the thread of the M12 plug. The thread is part of
’;haert?etallic housing. The housing is at the same potential as functional
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8.3 Connection unit CU416

2
M5 2x —1 O
|
ll |
1 Connection cable, connection to the machine
2 M12 socket, D-coded, Ethernet communication connection
M5 Connection for functional earth with M5 x 10 self-cutting/self-tapping (gas tightness) and ground strap

Fig. 8.3:

Connection unit CU416

Cable lengths as a function of operating voltage and load current

The maximum cable length is determined by voltage drops on the supply and signal lines.

The following conditions apply for the necessary operating voltage Ug at the input terminals of the connec-

tion unit:
» Uz must be greater than the permissible nominal voltage limit of 16.8 V.

NOTICE

The recommended operating voltage is 19 V!
Leuze electronic recommends an operating voltage Ug of 19 V at the input terminals of the con-
nection unit.
% The operating voltage should not be allowed to drop below the recommended value if possi-
ble.

» The necessary operating voltage Uz must also ensure the function of the downstream devices.

* Once the operating voltage Ug has been determined, check whether the resulting signal voltages
are sufficient for the downstream devices.
» Take into account the voltage drops in the safety sensor — up to 3.2 V — and on the signal wiring.
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24,0
23,5
23,0
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18,0
17,5
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0 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90

1 Operating voltage [V]
2 Cable length [m]
31lLoad =0A
4 |Load = 250 mA
5 ILoad = 500 mA
6 ILoad = 750 mA
71load =1A
8 lLoad =1.25 A
9lLoad=15A

10 ILoad =1.65 A

Fig. 8.4: Diagram for estimating the voltage drop on the supply line
¢ Maximum load current: 1 A with RSL 400 cable
1 mm?AWG18 for supply and 0.14 mm*AWG26 for signals
PNP/NPN changeover

The PNP/NPN changeover for signal inputs F1 ... F5, RES1 is performed via a jumper on the connection
unit. The reference potential for the signal inputs is set via the jumper:

» P: reference potential +24 V
* N: reference potential 0 V (GND)
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Fig. 8.5: Jumper for PNP/NPN changeover

PNP/NPN changeover occurs simultaneously for signals F1 ... F5, RES1.

8.4 Circuit diagram example
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2am 1 200mA 'f
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Leuze electronic Leuze electronic
ROTOSCAN RSL 400 MSI-SR4B
3 g age 3
442 ks d4 mi2Dcoded b
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A
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K3
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* Spark extinction circuit, suitable spark extinction provided
Fig. 8.6: RSL 420 with MSI-SR4B safety relay
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9.1

Configuring the safety sensor
To start up the safety sensor in your application, the safety sensor must be individually adapted using the
software. All configuration data is defined using the configuration and diagnostics software.
General procedure for configuring safety sensor
% Assessing the risk
* The system has been determined and its boundaries defined.
» The safety sensor has been selected as the safety component.

* The type of guarding has been determined (danger zone guarding, point of operation guarding, access
guarding).

% Calculating safety distance
Shape and size of the protective and warning fields

% Configuring the safety sensor

» Configuration and diagnostics software (see chapter 4 "Configuration and diagnostic software Sen-
sor Studio")

» Determine the configuration project (see chapter 9.3 "Determine the configuration project”)
« Configure the protective function (see chapter 9.4 "Configuring protective function")
% Checking function (see chapter 11 "Testing")

Defining safety configuration

Serious accidents caused by incorrect safety configuration!

The protective function of the safety sensor is only ensured if the safety sensor is correctly con-
figured for the intended application.

% Allow only competent persons to perform safety configuration.

% Select the safety configuration so that the safety sensor can be used as intended (see chap-
ter 2.1 "Intended use").

% Select the protective field dimensions and contours according to the safety distance calcu-
lated for the application (see chapter 7.1.1 "Calculation of safety distance S").

% Select the parameters of the safety configuration according to your risk analysis.

% After start-up, check the function of the safety sensor (see chapter 11.1 "Before the initial
start-up and following modifications").

Additional protection against manipulation when the monitoring time is increased!

If the monitoring time is increased to above 5 s or if manipulation protection is deactivated, the
system operator must introduce other measures to prevent manipulation.
% For example, make sure that the distance range in which manipulation is possible cannot be
accessed by personnel under normal operating conditions.
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NOTICE

0 OSSDs will switch off if no reflection signals are being measured!

If the safety sensor is unable to measure any reflection signals in a continuous scanning angle
of = 90° for a long period of time, the safety-related switching outputs switch off. In certain appli-
cation types (e.g. in buildings with extremely large distances), the safety sensor may not be able
to measure any reflection signals. For such application types, it is possible to set or deactivate
the monitoring times.

% In the CONFIGURATION menu, click the Other option.
= The OTHER dialog box opens.

% In the PROTECTION AGAINST MANIPULATION dialog box, define the monitoring time ac-
cording to your specific conditions.

= If the parking position is active, there will be no manipulation monitoring.

Prerequisites:

» The safety sensor is mounted (see chapter 7 "Mounting") and connected (see chapter 8 "Electrical con-
nection") correctly.

» Dangerous process is switched off, outputs of the safety sensor are disconnected, and the system is
protected against being switched back on.

» The size of the protective field is determined on the basis of the mounting location, the calculated
safety distances and additional distances.

» The start/restart operating mode required by the application has been determined.

» The conditions for field pair changeover, if required, have been determined.

» The configuration and diagnostics software for the safety sensor is installed on the PC (see chapter 4.2
"Installing software").

Many safety-relevant parameters are preset for each application in the configuration and diag-
nostics software. Use these preset values where possible.

Procedure
All configuration data is defined using the configuration and diagnostics software.
To configure the safety sensor, proceed as follows:
% Connect the PC to the safety sensor
% Start the software
+ Set up communication
» Determine the configuration project
% Configure the protective function using the project wizard
 Protective/warning field configuration
» Resolution and response time
» Start-up behavior
« Contactor monitoring
» E-stop linkage
 Field pair changeover
« Configuration of the signal outputs
% Save configuration project
% Transferring a configuration to the safety sensor
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% Create a record document for the device configuration and protective field dimensioning. The document
must be signed by the person responsible for the configuration.
To document the configuration, you can create a PDF file of the safety configuration or save the config-
uration and settings in an *.xml file.

The configuration data is stored in the connection unit of the safety sensor and is therefore also
available after replacement or repair of the scanner unit. The configuration data only needs to
be transferred again if changes are made to the configuration.

9.2 Connecting safety sensor to PC

9.2.1 Connection via Ethernet cable
Connect the Ethernet cable to the PC or to the network; see the document "Quick Start Guide RSL 400".

The TCP/IP protocol is used for communication via Ethernet.

9.2.2 Connection via Bluetooth

Prerequisites: Bluetooth communication of the safety sensor has been activated (see chapter 9.2.3 "Com-
munication between safety sensor and PC")

% Activate the Bluetooth interface on the PC.

% Select the safety sensor as the device for the Bluetooth connection.

Distance between safety sensor and PC

ﬂ The possible distance between safety sensor and PC depends on the quality of the Bluetooth
adapter that is used.
USB Bluetooth adapters with external rod antenna enable a larger operating range.

9.2.3 Communication between safety sensor and PC
The following communication settings are active when the safety sensor is delivered:
LAN
* DHCP: Obtain IP address automatically
Bluetooth
» Bluetooth module activated
» Device scan activated

You can change the communication settings on the PC using the configuration and diagnostics software in
order to, for example, assign a permanent IP address to the safety sensor in your network.

& Start the configuration and diagnostics software on your PC.
= The mode selection of the Project Wizard is displayed.

= If the mode selection is not shown, click the [Project Wizard] button ( & ) in the menu bar of the soft-
ware to start the project wizard.

% Select the configuration mode and click [Next].
= The Project Wizard displays the device selection list containing the configurable safety sensors.
% Select the safety sensor from the device selection list and click [Next].

= The initial screen for the configuration project is displayed together with information for identification of
the selected safety sensor.

% In the initial screen, click the SETTINGS tab.
= The SETTINGS menu opens.
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Assign permanent IP address
% Select the menu command Communication > LAN.
% In the DHCP dialog box, deactivate the Obtain IP address automatically checkbox.
% In the CONNECTION SETTINGS dialog box, enter the IP address information.

Activating/deactivating the Bluetooth interface
% Select the menu command Communication > Bluetooth.

% Activate/deactivate communication with the safety sensor via the Bluetooth interface using the Activate
Bluetooth module checkbox. If the Bluetooth module is deactivated, communication with the safety sen-
sor via the Bluetooth interface is not possible.

% Activate/deactivate the Bluetooth device scan using the Activate device scan checkbox. If the device
scan is deactivated, the safety sensor will not be found during the Bluetooth device scan. To allow com-
munication via the Bluetooth interface, you must enter the device identification of the safety sensor
manually.

9.3 Determine the configuration project
% Start the configuration and diagnostics software on your PC.
= The mode selection of the Project Wizard is displayed.

= If the mode selection is not shown, click the [Project Wizard] button ( & ) in the menu bar of the soft-
ware to start the project wizard.

NOTICE

During installation of the software, a user admin (without password query) is created so that you

can start the software without user identification. If other users are registered (Tools > User

management in the FDT frame menu), you must log in at the software with a user name and
password.

This setting allows you to connect to the safety sensor and to read out, upload, enter or change
the safety configuration and all settings using the RSL 400 device DTM. The password for the
safety sensor only needs to be entered (i.e. the access level only needs to be changed) when
the changes are downloaded to the safety sensor (see chapter 4.5.1 "Selecting access level").

% Select the configuration mode and click [Next].
= The Project Wizard shows the list of configurable safety sensors.

You can use a prepared configuration project as a template and make changes to it. To do so,
select the configuration mode Open a stored project file.

If you want to load the configuration project currently stored in the safety sensor to the PC, se-
lect the configuration mode Device selection with device scan and establishment of connection
(online).

% Select the safety sensor in the Sensor list and click OK.
Alternatively, you can select the safety sensor by entering the part number or by specifying the sensor
range and the sensor type.

= The device manager (DTM) of the safety sensor shows the initial screen for the configuration project.
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Fig. 9.1: Safety configuration using Configuration Wizard

The device manager (DTM) starts without querying the access level of the user. During commu-
nication with the safety sensor, the safety sensor does however query the access level of the
user. To change the access levels, see chapter 9.9 "Selecting access level".

9.4

Configuring protective function

Prerequisites: The safety distance, additional distances and protective field dimensions and contours have
been determined according to the mounting position (see chapter 7.1.1 "Calculation of safety distance S").

% In the initial screen, click the CONFIGURATION tab.
= The CONFIGURATION menu opens with the options:

Administration

OSSDs

If the OSSDs option is selected in the CONFIGURATION menu, the Protective function A option is
displayed.

Changeover order

The Changeover order option is only displayed if more than one protective/warning field pair is cre-
ated (see chapter 9.4.4 "Creating and configuring protective/warning field pairs").

Outputs
Other
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9.4.1

9.4.2

943

944

Creating simple safety configuration

To create a safety configuration for simple commissioning, you must first perform five configuration steps to
access the editor used for defining the contours of the protective and warning fields.

By clicking [Next], you can proceed to the next configuration step without selecting the corresponding op-
tion in the CONFIGURATION menu.

If you make changes to the default settings in a configuration step, first click the [Confirm] button and then
[Next].

% Administration

% OSSDs

% Protective function A
% Bank A1

% Outputs

Entering administration parameters
% In the CONFIGURATION menu, click the Administration option.
= The ADMINISTRATION dialog box opens.
% In the input fields, enter the device data and the project data for the configuration project.

Activating protective function and contactor monitoring
% In the CONFIGURATION menu, click the OSSDs option.
= The OSSDs dialog box opens.
% In the FUNCTION MODE list, select the protective function of the safety sensor.
= The Protective function A option is shown in the CONFIGURATION menu.

The changeover-capable protective/warning field pairs for the selected protective function are
defined in configuration banks.

% In the CONTACTOR MONITORING list, activate the contactor monitoring of the safety sensor:
« EDM OSSD A

« E-Stop

* OSSD linkage

The activated contactor monitoring (EDM) is assigned to indication signal outputs EA1 and/or
EA2. These signal outputs are thus disabled for the configuration of the signal outputs.

% Click the [Confirm] button.

Creating and configuring protective/warning field pairs
The changeover-capable protective/warning field pairs for the selected protective function are defined in
configuration banks. The configuration banks are shown in the navigation tree of the configuration menu as
"Bank", e.g. Bank A1.
Creating banks

% In the CONFIGURATION menu, click the Protective function A option.

= The PROTECTIVE FUNCTION A dialog box opens.

% Enter the description of the protective function in the input field.

% In the CONFIGURATION menu, right-click the Protective function A option.
Select Add configuration bank.

= The Add bank dialog box opens.
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% In the Bank list, select the number of the bank and click the [Add] button.
When you have added all banks for the protective function, click [Close].

= The Bank [x] option is shown for each added bank under Protective function A in the CONFIGURA-
TION menu.

Configuring banks

The resolution for hand, leg or body detection, the response time and start-up behavior of the safety sensor
and the field pair changeover for the protective/warning field pairs are configured via the banks.

For resolution, response time and DTS speed, select the values that you used for calculating the
safety distances and additional distances for the application assigned to the configuration bank.

% In the CONFIGURATION menu, select the bank the configuration of which you want to define.

= The RESOLUTION, RESPONSE TIME, START-UP BEHAVIOR and EXTENDED OUTPUT SIGNALS
dialog boxes are displayed.

% In the RESOLUTION dialog box, enter the resolution and, if applicable, the maximum speed of a driver-
less transportation system (DTS) in the input fields.

If in the Resolution and Max. DTS speed input fields you select values > 0, the application usu-
ally used for the bank is displayed in the Application field, e.g. Point of operation guarding.

For access guarding, point of operation guarding and danger zone guarding, you must select
Max. DTS speed = 0!

% In the RESPONSE TIME dialog box, select the response time of the safety sensor.

% In the START-UP BEHAVIOR dialog box, select the start-up behavior and the restart time of the safety
sensor.

Configuration of the start-up behavior is only implemented if the corresponding electrical signal
connections exist; see chapter 8 "Electrical connection".

% In the EXTENDED OUTPUT SIGNALS dialog box, activate the definition of output signals.
% Click the [Confirm] button.
% Configure all other banks of the protective function following the described procedure.

Create protective and warning fields
A field pair consists of one protective field and one warning field.

% In the CONFIGURATION menu, right-click the Bank 1 option under Protective function A
Select Add field pair.

= The Add field pair dialog box opens.

% In the Field pair list, select the number of the field pair and click the [Add] button. When you have
added all field pairs for the bank, click [Close].

= The added field pairs are shown in the CONFIGURATION menu as an option under Bank 1 under Pro-
tective function_A. The Parameters option is displayed for each field pair.

% Add the field pairs for the other banks of Protective function A if one protective function with multiple
configuration banks has been selected.

= The added field pairs are shown in the CONFIGURATION menu under Bank [x] under Protective func-
tion A.
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Configure protective and warning fields
Defining contours and boundaries for protective field and warning field
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~ . HTE : methods (see Defining protective and
1 Toolbar of field editor
2 Display of field coordinates
3 Structure of safety configuration
Fig. 9.2: Field editor with toolbar for field definition
% In the CONFIGURATION menu, click the field pair the protective and warning fields of which you want
to define.

% Click the E button and define the contours and boundaries of the protective field.

Determine protective field size!

The protective field size is determined by the calculated safety distances and additional dis-
tances that you determined for the application assigned to the configuration bank.

% Click the button and define the contours and boundaries of the warning field.

By right-clicking the field pair in the CONFIGURATION menu, you can calculate an autocontour
for the protective or warning field.

You can determine the display options for the field editor in the menu SETTINGS > Field editor
display options (see chapter 4.5.6 "SETTINGS").

% Configure all other field pairs of the configuration bank following the described procedure.

9.45 Configuring field pair monitoring
% In the CONFIGURATION menu, click the Parameters option of the field pair the protective and warning
fields of which you have defined.

% Select the monitoring mode for the field pair in the Field pair monitoring list.
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9.5

9.6

Defining permissible field pair changeovers
If monitoring of field pair changeover is activated, you can define the permissible sequence of field pair
changeovers.
Determining changeover mode
% In the CONFIGURATION menu, select the protective function A option.

% In the dialog box MODE FOR FIELD PAIR ACTIVATION AND CHANGEOVER, select the field pair ac-

tivation, the mode for field pair changeover and, if required, the changeover time.

Field pair activation Description
Changeover mode

Fixed selection of one field | Changeover of two field pairs
pair

Selection by signal inputs | Changeover of 10 field pairs (see chapter 5.7.3 "Changeover of ten field

Fixed changeover moment pairs in changeover mode Fixed changeover moment")

pair which at this time has a permanent and valid assignment. Field pair
changeover signals issued during the changeover time are ignored.

The inputs F1 - F5 are active.

When the changeover time has expired, the system changes over to the field

Selection by signal inputs | Changeover of 5 field pairs ()
Overlapped monitoring Both field pairs are monitored during the changeover time.
The inputs F1 - F5 are active.

% Click the [Confirm] button.

Determining changeover order
% In the CONFIGURATION menu, select the Changeover order option.
= The CHANGEOVER ORDER dialog box opens.
% In the MONITORING OF FIELD PAIR CHANGEOVER dialog box, activate the Monitoring option.

% In the MONITORING OF FIELD PAIR CHANGEOVER dialog box, define the sequence of field pair
changeovers according to your conditions.

% Click the [Confirm] button.

Configuring signal outputs

You can define which indication signals are transmitted to the individual indication signal connections.
% In the CONFIGURATION menu, select the Outputs option.

The OUTPUTS dialog box opens.
% For each usable connection, select the function group and the function of the indication signal.
% Click the [Confirm] button.

All signal outputs are high active, i.e. logical 1 or +24 V DC with an active signal.
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9.7 Saving configuration
To save the changed configuration loaded in the software, you can transfer the configuration and settings
to the safety sensor or save them in a file on the PC.
Saving safety configuration as PDF file
% In the CONFIGURATION menu, click the [Create PDF file of safety configuration] button.
% Determine the storage location and the file name for the safety configuration.
% Click [Save].
= The safety configuration is saved as a PDF file.

Saving configuration and settings as file

% In the CONFIGURATION menu or in the SETTINGS menu, click the [Save configuration and settings to
file] button.

% Determine the storage location and the name of the configuration file.
% Click [Save].
= The configuration and settings are saved in the file format *.xml.

Saving configuration project as file

% In the menu bar of the FDT frame menu, click the k- button.
Alternatively, select the menu command File > Save.

% Determine the storage location and the name of the configuration project file.
% Click [Save].

9.8 Transferring configuration project to safety sensor

The changes that you have made to the configuration only become effective when the changed configura-
tion project file is transferred to the safety sensor.

Prerequisites:
» The software and safety sensor are connected.
« The changed configuration project has been loaded in the software.
» The individual password for the access level Engineer is available.

« Only users with the access level Engineer can transfer configuration data to the safety sensor. To
change the access level, see chapter 9.9 "Selecting access level".

+ If no individual password has been defined for the access level Engineer, use the preset default
password (safety).

Alternatively, you can transfer a configuration project saved as a file on the PC directly to the
safety sensor.

% In the menu bar of the FDT frame menu, click the [download arrow] button. Alternatively: In the FDT
menu bar, select Device > Download parameters.

= The software asks for the access level and the password.

% Select the access level Engineer and enter the preset default password (safety) or the defined individ-
ual password.
Confirm with [OK].

% Before downloading the safety configuration, check whether you are connected to the correct safety
sensor.
Confirm the displayed safety notice with [Yes].
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Fig. 9.3:
The software transfers the data of the configuration project to the safety sensor.

Check before safety configuration is downloaded

After successful transfer, the safety sensor immediately enters safety mode, i.e. the safety-related switch-

ing outputs switch on if all conditions are fulfilled.

» The configuration data is saved in the connection unit of the safety sensor.

» A copy of the safety configuration is saved in the scanner unit of the safety sensor.
If, due to a device swap-out, the scanner unit is attached to a brand new, unconfigured connection unit,
the safety configuration is transferred from the scanner unit to the connection unit.

NOTICE

Observe the safety notices regarding changes to the configuration!

Transferring the safety configuration from the scanner unit to the connection unit corresponds to
reconfiguration of the system consisting of scanner unit and connection unit.

% Observe the relevant safety notices regarding changes to the configuration (see chapter 9.1
"Defining safety configuration™).

% Check the displayed signature.

% Confirm successful transfer of the safety configuration to the safety sensor with [OK].
The safety configuration has only been successfully transferred to the safety sensor when the confirma-
tion dialog is displayed during the download.
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Fig. 9.4:

Confirmation: safety configuration downloaded

The safety-related switching outputs will already have switched on if all conditions are fulfilled.

= The software has saved the configuration project in the safety sensor.

9.9 Selecting access level

Using the device manager (DTM) you can change the access level of the user, if necessary (see chapter
5.1 "Authorization concept of safety sensor").

% Click in the DTM menu bar on the Change access level button ().
= The Change access level dialog box opens.

% In the Authorization list, select the item Engineer, Expert or Observer and enter the default password
or the password defined for the individual user (see chapter 4.5.6 "SETTINGS").

» Default password for Engineer: safety
 Default password for Expert. comdiag
% Confirm with [OK].

9.10 Reset safety configuration

The device manager (DTM) can be used to reset the safety configuration to the default configuration (one
protective function, no restart).

% In the DTM menu bar, click the [Reset safety configuration] button.

= Users with the access level Engineer can additionally transfer the changed safety configuration to the
safety sensor (see chapter 9.8 "Transferring configuration project to safety sensor").
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10

10.1

10.2

10.3

Starting up the device

Improper use of the safety sensor may result in serious injury!

% Make certain that the entire device and the integration of the optoelectronic protective de-
vice was inspected by competent and instructed persons.
% Make certain that a dangerous process can only be started while the safety sensor is
switched on

Prerequisites:

« Safety sensor mounted (see chapter 7 "Mounting") and connected (see chapter 8 "Electrical connec-
tion") correctly

» Operating personnel were instructed in proper use

« Dangerous process is switched off, outputs of the safety sensor are disconnected, and the system is
protected against being switched back on

% After start-up, check the function of the safety sensor (see chapter 11.1 "Before the initial start-up and
following modifications™).

Switching on

Requirements for the supply voltage (power supply unit):
* Reliable mains separation is ensured.
» Current reserve of at least 3 A is available.
% Switch on the safety sensor.

Aligning the safety sensor

Faulty or incorrect alignment may result in an operating fault!
% The alignment performed during start-up should only be performed by qualified personnel.
% Observe the data sheets and mounting instructions of the individual components.

To simplify alignment during start-up, the safety sensors of the RSL 400 series have an integrated elec-
tronic spirit level.

% Align the safety sensor using the integrated electronic spirit level.

Unlocking start/restart interlock

Premature unlocking of the start/restart interlock may result in serious injury!

If the start/restart interlock is unlocked, the system can start up automatically.
% Before unlocking the start/restart interlock, make certain that no people are in the danger

zZone.

The responsible person can restore the ON state of the safety sensor following process interruptions (due
to triggering of protective function, failure of the voltage supply).

% Unlock the start/restart interlock using the reset button.
The safety-related switching outputs are only enabled if you hold down the reset button for between
0.12sand 4 s.
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10.4

10.5

10.6

Shutting down

Temporarily shutting down the machine with the safety sensor

When you shut down the machine with the safety sensor temporarily, you do not have to observe any more
steps. The safety sensor saves the configuration and starts again with the switch-on with this configuration.
Shutting down safety sensor and removing from machine

When you shut down the safety sensor and store it away for a later use, you must reset the safety sensor
to the factory settings.

% Reset the safety sensor to the factory settings using the software.
In the device manager (DTM) of the safety sensor, select the CONFIGURATION tab.
Click the [Reset safety configuration] button.

Restarting

Restarting the machine with the safety sensor

If you have only shut down the system with the safety sensor temporarily and are restarting the system
without any changes, you can restart the safety sensor with the configuration that applied with the shut-
down. The configuration remains saved in the safety sensor.

% Perform a function test (see chapter 11.3 "Periodically by the operator").

Starting up machine with safety sensor after modification or reconfiguration

If you have performed significant changes on the machine or have reconfigured the safety sensor, the
safety sensor must be checked as with the initial start-up.

% Test the safety sensor (see chapter 11.1 "Before the initial start-up and following modifications").

Starting up replacement scanner unit

The replacement scanner unit and the original scanner unit must be the same with regard to the following
points:

» Scanner unit type in accordance with name plate or downward compatible with previous scanner unit
with greater range and greater function range

» Mounting on the existing connection unit

Mounting and aligning replacement scanner unit

% Mount the replacement scanner unit on the connection unit instead of the original scanner unit (see
chapter 13.1 "Changing scanner unit").

Realignment of safety sensor not necessary!

Realignment of the safety sensor is not necessary since the replacement scanner unit is
mounted on the existing, aligned connection unit.

Transferring configuration to replacement scanner unit
The configuration stored in the connection unit is automatically transferred to the replacement scanner unit.

Malfunctioning of safety sensor due to incorrect configuration!

% The safety sensor configuration stored in the connection unit can only be adopted without
changes if the replacement scanner unit and the original scanner unit are downward com-

patible with respect to range and performance class.
A The replacement scanner unit will reject an invalid configuration.
% Change the configuration parameters of the safety sensor using the configuration and diag-

nostic software according to the performance class of the replacement scanner unit.

% Change the configuration parameters of the safety sensor using the configuration and diag-
nostic software according to the operating range of the replacement scanner unit.
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Transferring configuration with the PC
If the range and/or performance class of the replacement scanner unit is not compatible with the original
scanner unit, you must adapt the configuration of the safety sensor to the replacement scanner unit.
% Connect the safety sensor's Ethernet communication interface with the PC.
% Configure the safety sensor according to the range and performance class of the replacement scanner
unit (see chapter 9 "Configuring the safety sensor").
% Transfer the configuration to the safety sensor with the replacement scanner unit.

= The alphanumerical display confirms successful transfer of the configuration.
The replacement scanner unit is not compatible with the connection unit if the safety sensor displays a

fault.

Checking replacement scanner unit
The check performed on the replacement device depends on whether you automatically adopted the con-
figuration from the connection unit or whether you transferred the changed configuration to the safety sen-
SOfr.
% If you adopted the configuration from the connection unit, check the safety sensor using the checklist
for the daily test.
% If you transferred a new configuration to the safety sensor, check the safety sensor according to the
routine for initial start-up (see chapter 11.1.1 "Checklist for integrator — to be performed prior to the ini-
tial start-up and following modifications").
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1 Testing

NOTICE

& Safety sensors must be replaced at the end of their mission time (see chapter 15 "Technical
data").

% Always exchange entire safety sensors.

% For the tests, observe, if necessary, nationally applicable regulations.

% Document all tests in a comprehensible manner and include the configuration of the safety
sensor along with the data for the safety- and minimum distances in the documentation.

11.1 Before the initial start-up and following modifications

Unpredictable machine behavior during initial start-up may result in serious injury!
% Make certain that there are no people in the danger zone.

& Before they begin work, train the operators on their respective tasks. The training is the responsibility of
the operating company.

% Attach notes regarding daily testing in the respective national language of the operator on the machine
in a highly visible location, e.g. by printing out the corresponding chapter (see chapter 11.3 "Periodically

by the operator").

% Test the electrical function and installation according to this document.
Acc. to IEC TS 62046 and national regulations (e.g. EU directive 2009/104/EC), tests are to be performed
by competent persons in the following situations:

« Prior to initial commissioning

» Following modifications to the machine

 After longer machine downtime

 Following retrofitting or new configuration of the machine

% As preparation, check the most important criteria for the safety sensor according to the following check-
list (see chapter 11.1.1 "Checklist for integrator — to be performed prior to the initial start-up and follow-
ing modifications"). Completing the checklist does not replace testing by a competent person!

Not until proper function of the safety sensor is ascertained may it be integrated in the control circuit of the
system.

11.1.1 Checklist for integrator — to be performed prior to the initial start-up and following modifications

Completing the checklist does not replace testing by a competent person!
% If you answer one of the items on the check list with no, the machine must no longer be op-
erated (see table below).
% IEC/TS 62046 contains additional recommendations on testing protective devices.
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Tab. 11.1: Checklist for integrator — to be performed prior to the initial start-up and following modifications

Check: Yes |No n. a.
not ap-
plicable

Is the safety sensor operated acc. to the specific environmental conditions that
are to be maintained (see chapter 15 "Technical data")?

Is the safety sensor correctly aligned and are all fastening screws and connec-
tors secure?

Are safety sensor, connection cables, connectors, protection caps and com-
mand devices undamaged and without any sign of manipulation?

Does the safety sensor satisfy the required safety level (PL, SIL, category)?

Are the safety-related switching outputs (OSSDs) integrated in the downstream
machine control acc. to the required safety category?

Are switching elements that are controlled by the safety sensor monitored ac-
cording to the required safety level (PL, SIL, category) (e.g., contactors through
EDM)?

Are all points of operation near the safety sensor accessible only through the
protective field of the safety sensor?

Are the necessary additional protective devices in the immediate surroundings
(e.g., safety guard) properly mounted and secured against tampering?

If it is possible to be present undetected between the safety sensor and point
of operation: is an assigned start/restart interlock functional?

Is the command device for unlocking the start/restart interlock mounted in such
a way that it cannot be reached from within the danger zone and so that the
complete danger zone can be seen from the installation location?

Has the maximum stopping time of the machine been measured and docu-
mented?

Is the required safety distance maintained?

Does interruption with a test object intended for this purpose cause the danger-
ous movement(s) to stop?

Is the safety sensor effective during the entire dangerous movement(s)?

Is the safety sensor effective in all relevant operating modes of the machine?

Is start-up of dangerous movements reliably prevented if the protective field is
interrupted with a test object intended for this purpose?

Was the sensor detection capacity successfully tested (see chapter 11.3.1
"Checklist — periodically by the operator")?

Were distances to reflective surfaces taken into account during configuration
and no reflection bypasses subsequently detected?

Are notices for regular testing of the safety sensor legible to the operator and
are they located in a highly visible location?

Are changes to the safety function (e.g. protective field changeover) not easy
to achieve through tampering?

Are settings that could result in an unsafe state possible only by means of key,
password or tool?

Are there incentives that pose stimulus for tampering?

Were the operators instructed prior to starting work?
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11.2

11.3

To be performed periodically by competent persons

The reliable interaction of safety sensor and machine must be periodically tested by competent persons in
order to detect changes to the machine or impermissible tampering with the safety sensor.

Acc. to IEC/TS 62046 and national regulations (e.g., EU directive 2009/104/EC), tests of elements which
are subject to wear must be performed by competent persons at regular intervals. Testing intervals may be
regulated by nationally applicable regulations (recommendation acc. to IEC/TS 62046: 6 months).

% Have all tests performed by competent persons.
% Observe the nationally applicable regulations and the time periods specified therein.

% As preparation, observe the checklist (see chapter 11.1 "Before the initial start-up and following modifi-
cations").

Periodically by the operator

The function of the safety sensor must be checked regularly (e.g., daily, on shift change, monthly or in an
even longer cycle) according to the following checklist. The frequency of the checks is determined by
means of the risk analysis performed by the operating company.

Due to complex machines and processes, it may be necessary under certain circumstances to check some
points at longer time intervals. Observe the classification in "Test at least" and "Test when possible".

Unpredictable machine behavior during the test may result in serious injury!

f:} % Make certain that there are no people in the danger zone.
& Before they begin work, train the operators on their respective tasks and provide suitable

test objects and an appropriate test instruction.

11.3.1 Checklist — periodically by the operator

% If you answer one of the items on the check list with no, the machine must no longer be op-
erated (see chapter 11.1.1 "Checklist for integrator — to be performed prior to the initial start-
up and following modifications").
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Tab. 11.2: Checklist — regular function test by trained operators/persons

Are safety sensor and connectors securely mounted and free of obvious signs of damage,
changes or tampering?

Were obvious changes made to access or entry possibilities?

Test the effectiveness of the safety sensor:

1. The LED 1 on the safety sensor must illuminate green (see chapter 3.3 "Display ele-
ments").

2. Interrupt the protective field using a suitable opaque test object (see figure).

Checking the protective field function with test rod

Does the LED 1 on the safety sensor illuminate constantly red while the protective field is
interrupted?

Tab. 11.3:  Checklist — regular function test by trained operators/persons

Protective device with approach function: during machine operation, the protective field is
interrupted with the test object — are the obviously dangerous machine parts stopped with-
out noticeable delay?

Protective device with presence detection: the protective field is interrupted with the test
object — does this prevent operation of the obviously dangerous machine parts?
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121

12.2

Diagnostics and troubleshooting

What to do in case of failure?

After switching the safety sensor on, the display elements assist in checking the correct functionality and in
faultfinding (see chapter 3.3 "Display elements").

In case of failure, you can determine the fault from the LED displays and read a message from the display.
With the error message you can determine the cause of the error and initiate measures to rectify it.

NOTICE

If the safety sensor responds with an error display, you will often be able to eliminate the
cause yourself!

% Switch off the machine and leave it switched off.
% Analyze the cause of the fault using the diagnostics displays and rectify the fault.

% If you are unable to rectify the fault, contact the Leuze electronic branch responsible for you
or call the Leuze electronic customer service (see chapter 14 "Service and support").

Diagnostics displays

The diagnostics displays consist of one letter plus four numbers, divided into classes consisting of letters
and the first number.

Diagnostics classes:
* | (Information)
* No OSSD switch-off
* Unhindered operation possible

* U (Usage)
Application error
E (External)
External fault
* F (Failure)

internal device error

* OSSD switch-off
» Self test unsuccessful

e Hardware error

* P (Parameter)
Inconsistency in configuration

Tab. 12.1: Diagnostics displays in order of ascending ID number
Diagnostic | Diagnostic message Measure
ID
uo370 Input level at the electrical inputs is unclear. | Check the wiring of the safety sensor.
P0409 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known bank switchover. configuration. The type of safety sensor must

be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0410 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known output signals. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0413 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known inputs SE1 and SE2. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
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Diagnostic | Diagnostic message Measure
ID
P0414 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known EDM inputs. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0415 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known field pair monitoring mode. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0416 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known field pair monitoring parameters. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0417 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known field pair monitoring mode. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0419 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known monitoring parameter for the configuration. The type of safety sensor must
changeover order. be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0420 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known monitoring mode of the field pair configuration. The type of safety sensor must
changeover. be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0421 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known parameter for field pair changeover |configuration. The type of safety sensor must
monitoring. be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0422 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known field pair selection mode. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0423 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known field pair selection parameter. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0424 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known parameter for manipulation monitor- | configuration. The type of safety sensor must
ing. be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0425 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known configuration of the output signals. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0426 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known resolution. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0427 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known parameter. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
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Diagnostic | Diagnostic message Measure
ID
P0429 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known start/restart mode. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0430 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known start mode. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0431 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known restart mode. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
P0432 Safety configuration is not compatible: un- | Swap out the safety sensor or change the
known OSSD stop mode. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
u0573 EDM fault at system start. Check the wiring of the downstream relays
and that they are functioning correctly.
uo574 Switching fault, EDM at OSSD A: external Check the wiring of the downstream relays
relay does not switch off. and that they are functioning correctly.
uo575 Switching fault, EDM at OSSD A: external Check the wiring of the downstream relays
relay does not switch on. and that they are functioning correctly.
u0576 Switching fault, EDM at OSSD B: external Check the wiring of the downstream relays
relay does not switch off. and that they are functioning correcily.
uos77 Switching fault, EDM at OSSD B: external Check the wiring of the downstream relays
relay does not switch on. and that they are functioning correctly.
u0580 Switching fault at inputs SE1 and SE2; ex- | Check the wiring of the external safety device
ternal safety device does not switch in ac- and that the parameter settings in the configu-
cordance with the specifications. ration are correct.
u0582 Field pair changeover is not performed in Check the changeover times of function inputs
accordance with the specifications config- F1 to F10 or the parameter settings in the
ured in the safety sensor: overlap time too | configuration.
long.
u0583 Field pair changeover is not performed in Check the wiring and the changeover times of
accordance with the specifications config- function inputs F1 to F10.
ured in the safety sensor: no signal for field
pair activation.
u0584 Field pair changeover is not performed in Check the changeover times of function inputs
accordance with the specifications config- F1 to F10 or the parameter settings in the
ured in the safety sensor: changeover time | configuration.
exceeded.
u0585 Field pair changeover is not performed in Check the wiring of function inputs F1 to F10
accordance with the specifications config- and that the parameter settings in the configu-
ured in the safety sensor: changeover order |ration are correct.
not observed.
u0792 Field pair changeover without release. Check the release signal for field pair
changeover or change the safety configura-
tion.
u0793 Field pair changeover without request. Check the request signal for field pair
changeover or change the safety configura-
tion.
u0849 Field pair changeover not permitted. Check the wiring of the field pair inputs.
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Diagnostic | Diagnostic message Measure

ID

E0588 Optics cover is soiled. Clean the optics cover.

10604 Optics cover is soiled. Clean the optics cover as soon as possible.
Sensor is still in safety mode.

P0653 Safety configuration is not compatible: pro- | Swap out the safety sensor or change the

tective/warning field radius too large. configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0654 Field pair changeover is not performed in Check the wiring of function inputs F1 to F10
accordance with the specifications config- and that the parameter settings in the configu-
ured in the safety sensor: field pair not de- | ration are correct.
fined.

10660 Field pair changeover is not performed in Check the wiring of function inputs F1 to F10
accordance with the specifications config- and that the parameter settings in the configu-
ured in the safety sensor: no field pair acti- | ration are correct.
vated at system start.

u0661 Safety-related switching outputs (OSSDs) Check the wiring of the OSSDs.
cannot be switched: short circuit with 0 V,
+24 V DC or between OSSDs.

10719 Timeout of signals RES1 or RES2 (acknowl- | Check the wiring of inputs RES1 and RES2.
edgment button, start/restart). The time specifications for start/restart must

be observed.

P0O747 Safety configuration is not compatible: pro- | Change the dimensions and contour of the
tective/warning field radius too small. protective field in the configuration. The mini-

mum range of the protective field must be ob-
served.

10825 Simulation mode has been activated. The safety-related switching outputs (OSSDs)
have been switched off.

10826 Simulation mode has been deactivated. Safety sensor is again in safety mode.
CAUTION!

Be aware of potential hazards which can oc-
cur when the machine is started up!

10859 Configuration was reset. +24 V detected at RES input after switch-on.
The communication parameters were reset to
default values.

11004 Field violation due to glare. Mount the safety sensor so that the light

(With switch-off of the OSSDs) source does not hit the outlet disc directly.

11005 Dazzled RSL. Mount the safety sensor so that the light
(Without switch-off of the OSSDs) source does not hit the outlet disc directly.

F... The monitoring functions have detected an | Create the service file (see chapter 4.5.5 "DI-
internal error. AGNOSIS") and contact the Leuze electronic

customer service (see chapter 14 "Service
and support").
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13 Care, maintenance and disposal

13.1 Changing scanner unit
If the safety sensor check or an error message indicates a defective scanner unit, change the scanner unit.
Only a trained and competent person is permitted to change the scanner unit.
The scanner unit is changed as follows:

» Detach the scanner unit from the connection unit.
» Attach the replacement scanner unit to the connection unit.

Safety sensor malfunction caused by dirt!
% Perform all work in an environment which is as dust-free and dirt-free as possible.

% Do not touch any of the parts inside the device.

Malfunctioning of safety sensor due to incompatibility of connection unit and scanner
unit! Malfunctioning of safety sensor due to incorrect configuration!

% Wherever possible, replace the scanner unit with a scanner unit with the same range and
performance class (e.g. RSL 420-M with RSL 420-M). The safety sensor configuration
stored in the connection unit is only adopted without changes if the new scanner unit sup-
ports all configured functions.

% Change the configuration parameters of the safety sensor using the configuration and diag-
nostic software according to the performance class of the scanner unit or of the connection

unit.
A If a scanner unit is attached to a connection unit with a lower performance class (e.g. scan-
ner unit RSL 430 to connection unit CU416), the integrated cable management of the con-
nection unit means that only the functions of the lower performance class (of the connection
unit) are available.
If a scanner unit is attached to a connection unit with a higher performance class (e.g.

RSL 420 scanner unit to CU429 connection unit), the performance of the scanner unit re-
stricts the functions to those of the lower performance class (of the scanner unit).

% Change the configuration parameters of the safety sensor using the configuration and diag-
nostic software according to the operating range of the replaced scanner unit. If the scanner
unit is replaced with a scanner unit with a different range (e.g. RSL 420-L with RSL 420-M),
you must check and, if necessary, adapt the configuration of the safety sensor.

Detailed information on attaching the scanner unit can be found in the document "Quick Start
Guide RSL 400"

% Undo the quick-release fasteners on both sides of the scanner unit.
% Pull the scanner unit off the connection unit.
% Place the new scanner unit on the connection unit.

% Connect and lock the new scanner unit using the quick-release fasteners on both sides.
% Check the configuration of the safety sensor (see chapter 9 "Configuring the safety sensor").

If a preconfigured scanner unit is attached to a brand new, unconfigured connection unit, the
safety configuration stored in the scanner unit is transferred to the connection unit and you can
use the safety sensor without reconfiguration after a restart.

% Check the safety sensor according to the routine for initial start-up (see chapter 11.1.1 "Checklist for in-
tegrator — to be performed prior to the initial start-up and following modifications").
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13.2 Cleaning the optics cover

Clean the optics cover as required by the application-related load rating.

Use the cleaning set consisting of special cleaning agent and cleaning cloths for cleaning (see chapter 17

"Order guide and accessories").

The procedure for cleaning depends on the kind of contamination:

Soiling

Cleaning

Particles, loose, scouring

Vacuum without touching or blow away softly, oil-free
Wipe free in one swipe with cleaning cloth

Particles, loose, non-scouring

Vacuum without touching or blow away softly, oil-free
or
Wipe free in one swipe with cleaning cloth

Particles, sticking

Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Particles, statically charged

Vacuum without touching

Wipe free in one swipe with cleaning cloth soaked with cleaning
agent

Particles/drops, smearing

Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Water drops

Wipe free in one swipe with cleaning cloth

Oil drops

Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Fingerprints

Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Scratches

Change optics cover

NOTICE
The wrong cleaning agents or cloths will damage the optics cover!
% Do not use any scouring cleaning agents or scratching cloths.

NOTICE

If cleaning takes longer than four seconds, e.g. with fingerprints, the safety sensor displays a
fault of optics cover monitoring. After cleaning is complete, the safety sensor resets itself auto-
matically.

% Clean the optics cover over the entire 360° range.

% Soak cloth with cleaning agent.

% Wipe optics cover free in one swipe.
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% Clean not only the optics cover, but also the reflector ring under the cap.

1 Reflector ring

Fig. 13.1: Reflector ring

NOTICE

Internal monitoring of optics cover!
% The monitored area is dependent on the configuration and can be smaller than the entire
scanning range of 270°.
% On account of device safety, the internal monitoring of the optics cover monitors a range
that is larger than specified by the configured protective field.

O

13.3 Servicing
The device does not normally require any maintenance by the operator.
Repairs to the device must only be performed by the manufacturer.
% For repairs, contact your responsible Leuze electronic subsidiary or Leuze electronic customer service
(see chapter 14 "Service and support").

13.4 Disposing
% For disposal observe the applicable national regulations regarding electronic components.
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14 Service and support

24-hour on-call service at:
+49 7021 573-0

Service hotline:
+49 7021 573-123

E-mail:
service.protect@leuze.de

Return address for repairs:
Servicecenter

Leuze electronic GmbH + Co. KG
In der Braike 1

D-73277 Owen/Germany
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15

15.1

Technical data

General specifications

Tab. 15.1: Safety-relevant technical data

Type in accordance with IEC/EN 61496 Type 3
SIL in accordance with IEC 61508 SIL 2
SILCL in accordance with IEC/EN 62061 SILCL 2
Performance Level (PL) in accordance with PLd

EN ISO 13849-1

Category in accordance with EN ISO 13849-1 Cat. 3
Average probability of a failure to danger per hour |9x10% 1/h
(PFHy)

Mission time (T,,) 20 years
Tab. 15.2: Optics

Laser protection class in accordance with Class 1

EN 60825-1

Wavelength 905 nm (infrared)

Impulse duration 2.5ns

Maximum output power (peak) 35W

Pulse frequency of laser transmitter 90 kHz

Scanning rate 25 scans/s, equal to 40 ms/scan

Scanning angle Max. 270 °

Angular resolution 0.1°

Tolerance field of reference contour + 200 mm

Tab. 15.3: Protective field data

Safety sensor RSL 410 RSL 420 RSL 430 RSL 440
RSL 425 RSL 445

Number of field pairs 1 10 10 +10 100

Reference contour selectable X X X X

Minimum adjustable range 200 mm

Detection range of the test object from the housing
edge

The detection capability is limited in the 0 mm to
50 mm range to increase availability.

Diffuse reflectance PF minimum

1.8 %
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Tab. 15.4: Protective field range
Device range S M L XL
Resolution [mm)] Protective field range [m]
150 3.00 4.50 6.25 8.25
70 3.00 4.50 6.25 8.25
60 3.00 4.50 6.25 8.25
50 3.00 4.50 6.25 6.25
40 3.00 4.50 4.50 4.50
30 3.00 3.50 3.50 3.50
Tab. 15.5: Warning field data
Safety sensor RSL 410 RSL 420 RSL 430 RSL 440
RSL 425 RSL 445
Number of field pairs 1 10 10 +10 100
Warning field range 0...20m
Object size 150 mm x 150 mm
Diffuse reflectance WF minimum Min. 10%
Tab. 15.6: Measurement field data
Detection range 0...50m
Diffuse reflection 90 %
Radial resolution 1 mm
Lateral resolution 0.1°
Tab. 15.7: Measurement field data for RSL 425
Min. Typical Max.
Detection range Diffuse reflection > 90% 0..50m
Distance resolution, radial 5 mm
Distance resolution, lateral 0.1°
Systematic measurement | Diffuse reflection:
error 1.8% ... retro-reflector
Drneas = Dreal Measurement range:
0.2m...25m -20 mm -10 mm +0 mm
Measurement value noise |10 10 mm
+ Diffuse reflection:
1.8% ... 20%
Measurement range:
Om...9m
+ Diffuse reflection:
20% ... retro-reflector
Measurement range:
Om...25m
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Min. Typical Max.
Laser spot height 10m 60 mm
20m 165 mm
30m 265 mm
40 m 285 mm
Laser spot width 10m 13 mm
20m 24 mm
30m 40 mm
40 m 57 mm
300
250 :. --ll-l-lhpl-liIl..rlniqiql:i._........-'. @
200 ¥
150
100 ___-_-(:)
501
D 1 1 1 1 J @
0,6 5 10 15 20 25
1 Object distance [m]
2 Signal strength
3 Retro-reflector film
4 White surface
Fig. 15.1: Signal strength curves depending on the distance

The figure shows a typical curve of the signal strength transmitted by the safety sensor as a function of the
measured object distance and object diffuse reflection for the following boundary conditions:

» Angle of incidence of the laser beam: 0°
» Share of area of the light spot on the object: 100%
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Tab. 15.8: Electrical supply

RSL 420 voltage supply

24V DC (+20% / -30%)

Power supply unit/battery

Supply acc. to IEC 742 with secure mains supply
isolation and equalization for power outages of up
to 20 ms acc. to EN 61496-1.

Overcurrent protection

Via 2 A semi-time-lag fuse in the cabinet

Note: With high external loads at the switching out-
puts (total current > 700 mA), the fuse rating must
be adjusted to 2.5 A.

Current consumption

Approx. 700 mA (use power supply unit with 3 A)

Power consumption

17 W with 24 V plus output capability

Overvoltage protection

overvoltage protection with protected limit stop

Protective conductor

Connection required

Device connection

Connection cable, 16-wire

Connection socket for Ethernet/communication

M12-4 connector, D-coded

Tab. 15.9: Inputs

Reset

+24 V, dynamically monitored (0.12 s to 4 s)

Field pair changeover

Selection of 10 field pairs via 5 control cables
+24 V, dynamically monitored

Signal definition:

High/logical 1

16-30V

Low/logical 0

<3V

Tab. 15.10:  Safety-related switching outputs

OSSD transistor safety-related switching outputs

2 safe PNP semiconductor outputs
Short-circuit proof, cross circuit monitored

Minimum Typical Maximum
Response time 80 ms 1000 ms

(2 scans) (25 scans)
Switching voltage high active Ug—-3.2V
Switching voltage low 20V
Switching current 300 mA
Cut-off frequency f, 1 kHz
Load capacity C,,.q 100 nF
Cable length between safety sensor and load see chapter 8.3 "Connection unit CU416"
Cabile resistance 15Q
Test pulse width 60 ps 110 ps
Test pulse distance 35 ms 40 ms 40 ms

The safety-related transistor outputs perform the spark extinction. With transistor outputs, it is

therefore neither necessary nor permitted to use the spark extinction circuits recommended by

contactor or valve manufacturers (RC elements, varistors or recovery diodes), since these con-
siderably extend the decay times of inductive switching elements.
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Tab. 15.11:  Inputs and outputs

Properties Max. output current I, | Min. input current |, | Typical connection
components

E=Input 4 mA Switching contacts

(F1-F5) PNP/NPN, can be changed (-4 mA) control/sensor output

over together

E=Input - 10 mA Start/restart

(RES1) PNP/NPN changeover to- (-10 mA)

gether with F1-F5

E=Input 4 mA E-Stop input

(SE1/SE2) changeover (<1 mA=0OFF) OSSD linkage

EX/A = changeover-capable 20 mA 10 mA Auxiliary contact of

(EA1) (-20 mA) (-10 mA) power contactor
(EDM)

AX=output 100 mA - Lamp (PNP only)

Current-limited, short-circuit proof (-20 mA) Control input (PNP/

(A1, MELD) NPN)

Signal definition:

High/logical 1 16-30V

Low/logical 0 <3V

Tab. 15.12:  Bluetooth

Frequency band

2400 ... 2483.5 MHz

Radiated transmitting power

Max. 4.5 dBm (2.82 mW), class 2

Tab. 15.13: Software

Configuration and diagnostics software

Sensor Studio for Windows 7 and Windows 8.1

Tab. 15.14:  General system data

Degree of protection

IP 65 in acc. with IEC 60529

Protection class

Il in accordance with EN 61140

Ambient temperature, operation

0...+50°C

Ambient temperature, storage

-20 ... +60 °C

Humidity

DIN 40040, table 10, code letter E (reasonably dry)

Interference rejection

In acc. with DIN EN 61496-1 (type 4), also in acc.
with DIN 40839-1/3 test pulses 1, 2, 3a, 3b and 5

Vibration stress over 3 axes

In acc. with IEC 60068 part2 -6, 10 - 55 Hz
max 5 G

Continuous shock over 3 axes

In acc. with IEC 60068 part 2 - 29, 10 G, 16 ms

Disposal

Specialist disposal required

Housing

Diecast zinc, plastic

Standard version dimensions (ensure free space for
connector with fixing and connection cable)

140 x 149 x 140 (W x Hx D) in mm

Weight of standard version incl. connection unit

Approx. 3 kg

Distance, beam level center to bottom housing edge

104 mm
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Tab. 15.15: Patents

US patents US 7,656,917 B
US 7,696,468 B
US 8,520,221 B
US 2016/0086469 A

15.2 Dimensions
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all dimensions in mm
1 Beam level

Fig. 15.2: Dimensions safety laser scanner with connection unit
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1 Reference point for distance measurement and protective field radius

Fig. 15.5:

Dimensions of scanning range

+135°

Mounting dimensions safety laser scanner with connection unit

Minimum space requirements for installation and replacement of scanner unit
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15.3 Dimensional drawings: Accessories
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Fig. 15.6: BTU8B00OM mounting system
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Fig. 15.7: BTF815M mounting bracket
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Fig. 15.8: BTF830M mounting bracket
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160

169

all dimensions in mm

Fig. 15.9: Loop guard BTP800M
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Fig. 15.10:  BT840M mounting bracket
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Fig. 15.11:

Mounting bracket BT840M, view A
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Fig. 15.12:  BT856M mounting bracket
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Fig. 15.13:  Mounting bracket BT856M, view A

Leuze electronic RSL 420 112



& Leuze electronic Technical data

122 7
0 o) |
& N\
o @)
O O
0 O o)
@) O
& @
= =7/
120,4
130
142

all dimensions in mm

Fig. 15.14:  Drilling template for adapter plate, RS4/ROD4 BT800MA
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The mounting plate BTU804MA supplements the old mounting system of the RS4/ROD4 for the mounting
system BTU8S00M.

Fig. 15.15:  BTU804MA mounting plate
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15.4

Representation of safety sensor status

The table lists all logic and electrical signals that are present in the safety sensor. The signal names are
used consistently throughout the configuration and diagnostics software (device DTM), in the event log and

in the data telegram.

Tab. 15.16:  Status profile
Byte |Bit Signal Description }ll:'!ue y:!ue Default
0 -—- - Type (model) of status profile. -—- 1
Extensions require new type of
status profile
1 -—- OP-MODE Operating mode: -—- -—- 1
+ 1: Safety mode
+ 2: Simulation mode
Messages and OSSDs
2 7 ERROR Collective message: off message |0
Error with switch-off
6 ALARM Collective message: off message |0
Warnings with switch-off (also win-
dow warning)
5 SCREEN Contamination display for optics off message |0
cover
Warning and switch-off
EDM EDM collection error off message | ---
FIELD PAIR Collective message: off message | ---
Fault detected by field pair selec-
tion monitoring
2 E-STOP Error with OSSD linkage / E-Stop | off message | ---
monitoring
1 A-OSSD OSSD state off on 0
Protective function A
0 B-OSSD OSSD state off on 0
Protective function B
Emergency stop and parking
3 7 Status-Input-SE Status of the inputs SE1 and SE2 | off on 0
E-Stop
6 Mode-PARK Park request fulfilled off parked |0
5 Reserved - - 0
4 reserved -— -—
3 reserved - -
2 Reserved - - - -
1 Reserved - -
0 Reserved - -
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Byte |Bit Signal Description y:'!ue y:l!ue Default
Electrical signals at sensor connection
4 7 F1 Control input -— -— 0
Input group 0
6 F2 Control input - 0
Input group 0
5 F3 Control input - 0
Input group 0
4 F4 Control input -— _— —
Input group 0
3 F5 Control input - — -
Input group 0
2 F6 Control input -
Input group 1
1 F7 Control input -
Input group 1
0 F8 Control input - - —
Input group 1
5 7 F9 Control input -— - 0
Input group 1
6 F10 Control input - 0
Input group 1
5 RES1 Start input - 0
Protective function A
4 RES2 Start input - - —
Protective function B
3 EA1 EDM input -
Protective function A
2 EA2 EDM input -
Protective function B
1 EA3 - -
0 EA4 - -
6 7 SE1 Linkage input - —
6 SE2 Linkage input -
5 PNP-NPN PNP/NPN changeover npn pnp
4 A1 Output - - —
3 A2 Output — — —
2 A3 Output - - -
1 A4 Output . - —
0 MELD Output -
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Numbers 1 ... 10

Byte |Bit Signal Description }'I:'!ue y:!ue Default
7 - Reserved - -—-
8-11 [31-0 |SCAN Consecutive numbering of scans | --- value
uint32 Resetting to 0 by switching off
Protective function A
12 7 A-ACTIVE Protective function A is active / off Active 0
configured
6 A-WF-VIO Status of active warning field violation |free 0
Protective function A
5 A-PF-VIO Status of active protective field violation |free 0
Protective function A
4 A-RES Start/restart interlock active off Active 0
Start Request A
3 A-CLEAR Internal signal OSSD A off on 0
2 Reserved - - - -
1 Reserved - -—-
0 Reserved - -
Field pair selection A
13 7-4 A-BANK-SEL Selected bank A --- 0
Numbers 1 ... 10
3-0 A-PAIR-SEL 1 First selected field pair A -—- 0
Numbers 1 ... 10
14 7-4 A-PAIR-SEL 2 Second selected field pair A -—- - 0
Numbers 1 ... 10
3-0 A-PAIR-SEL 3 Third selected field pair A --- 0
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Byte |Bit Signal Description Value Value Default
"™ e
Output signals A
15 7 A-WF-VIO-SEG-1 Status of active warning field seg- |violation |free 0
ment
Protective function A
6 A-WF-VIO-SEG-2 Status of active warning field seg- |violation |free 0
ment
Protective function A
5 A-PF-VIO-SEG-1 Status of active protective field violation |free 0
segment
Protective function A
4 A-PF-VIO-SEG-2 Status of active protective field violation |free 0
segment
Protective function A
3 A-FP-SEL-1 Defined field pair selected off selected |0
Protective function A
2 A-FP-SEL-2 Defined field pair selected off selected |0
Protective function A
1 Reserved - -
0 Reserved - - - -
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16 Standards and legal regulations

The following national and international legal regulations apply for start-up, technical tests and handling of
safety sensors:

» Machinery directive 2006/42/EC [1]

» Low voltage directive 2006/95/EC [2]
» Electromagnetic compatibility 2004/108/EC [3]
» Use of Work Equipment Directive 89/655/EEC supplemented by Directive 95/63 EC [4]
» Hazardous substances 2002/95/EC
+ OSHA 1910 Subpart O [5]
 Vibration EN 60068-2-6 [19]

* Eye safety (measurement laser) EN 60825-1 [20]

« Safety regulations

» Accident-prevention regulations and safety rules [6]

» Betriebssicherheitsverordnung (Ordinance on Industrial Safety and Health) and employment protection
act [7]

* Product Safety Law (ProdSG) [8]
» Standards for risk assessment, e.qg.

EN 1SO 12100 [9]

EN ISO 13849-1, -2 + Ber.1:2009 [10]
IEC 61508-1 to -7 [11]

EN IEC 62061 [12]

EN IEC 60204 [18]

« EN ISO 13849-1:2009 [13]
- EN ISO 13855:2010 [14]
« EN/IEC 61496-3 [15]

« EN 1525 [16]

- EN 999 [21]

- IEC/TS 62046:2008 [17]
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Order guide and accessories

Scope of delivery
» 1 self-adhesive notice sign "Important notes and notes for the machine operator”

» 1 Original operating instructions "Safe implementation and operation" (PDF file on data carrier)
* 1 print document "Quick Start Guide RSL 400"

Tab. 17.1:

Part numbers for RSL 420

Part no.

Article

Description

53800209

RSL420-S/CU416-5

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

Connection: cable, 16-wire, length 5 m
Ethernet: M12, 4-pin

3.0m

53800210

RSL420-M/CU416-5

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

Connection: cable, 16-wire, length 5 m
Ethernet: M12, 4-pin

45m

53800211

RSL420-L/CU416-5

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

Connection: cable, 16-wire, length 5 m
Ethernet: M12, 4-pin

6.5m

53800212

RSL420-XL/CU416-5

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

8.256 m
Connection: cable, 16-wire, length 5 m
Ethernet: M12, 4-pin

53800213

RSL420-S/CU416-10

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

Connection: cable, 16-wire, length 10 m
Ethernet: M12, 4-pin

3.0m

53800214

RSL420-M/CU416-10

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

Connection: cable, 16-wire, length 10 m
Ethernet: M12, 4-pin

45m

53800215

RSL420-L/CU416-10

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

Connection: cable, 16-wire, length 10 m
Ethernet: M12, 4-pin

6.5m

53800216

RSL420-XL/CU416-10

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

8.25m
Connection: cable, 16-wire, length 10 m
Ethernet: M12, 4-pin

53800217

RSL420-S/CU416-25

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

Connection: cable, 16-wire, length 25 m
Ethernet: M12, 4-pin

3.0m

53800218

RSL420-M/CU416-25

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

Connection: cable, 16-wire, length 25 m
Ethernet: M12, 4-pin

45m

53800219

RSL420-L/CU416-25

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.

Connection: cable, 16-wire, length 25 m
Ethernet: M12, 4-pin

6.5m
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Part no.

Article

Description

53800220

RSL420-XL/CU416-25

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.
8.25 m

Connection: cable, 16-wire, length 25 m
Ethernet: M12, 4-pin

53800248

RSL420-S/CU411-RS4

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.
3.0 m; RS4 adapter

Connection: cable, 11-wire, length 0.6 m, SUB-D 15
Ethernet: M12, 4-pin

53800249

RSL420-M/CU411-RS4

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.
4.5 m; RS4 adapter

Connection: cable, 11-wire, length 0.6 m, SUB-D 15
Ethernet: M12, 4-pin

53800250

RSL420-L/CU411-RS4

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.
6.5 m; RS4 adapter

Connection: cable, 11-wire, length 0.6 m, SUB-D 15
Ethernet: M12, 4-pin

53800251

RSL420-S/CU416-300-
WPU

1 OSSD pair; 10 field pairs; 4 10s; protective field range max. 3.0
Connection: 0.3 m cable with 16-pin connector

Ethernet: M12, 4-pin

m

53800252

RSL420-M/CU416-300-
WPU

1 OSSD pair; 10 field pairs; 4 10s; protective field range max. 4.5
Connection: 0.3 m cable with 16-pin connector

Ethernet: M12, 4-pin

m

53800253

RSL420-L/CU416-300-
WPU

1 OSSD pair; 10 field pairs; 4 10s; protective field range max. 6.5
Connection: 0.3 m cable with 16-pin connector

Ethernet: M12, 4-pin

m

53800254

RSL420-XL/CU416-300-
WPU

1 OSSD pair; 10 field pairs; 4 10s; protective field range max.
8.25m

Connection: 0.3 m cable with 16-pin connector
Ethernet: M12, 4-pin

Tab. 17.2:

Part numbers for RSL 425

Part no.

Article

Description

53800267

RSL425-S/CU416-5

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 3.0 m

Connection: cable, 16-wire, length 5 m
Ethernet: M12, 4-pin

53800268

RSL425-M/CU416-5

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 4.5 m

Connection: cable, 16-wire, length 5 m
Ethernet: M12, 4-pin

53800269

RSL425-L/CU416-5

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 6.5 m

Connection: cable, 16-wire, length 5 m
Ethernet: M12, 4-pin
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Part no. |Article

Description

53800270 | RSL425-XL/CU416-5

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 8.25 m

Connection: cable, 16-wire, length 5 m
Ethernet: M12, 4-pin

53800271 | RSL425-S/CU416-10

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 3.0 m

Connection: cable, 16-wire, length 10 m
Ethernet: M12, 4-pin

53800272 | RSL425-M/CU416-10

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 4.5 m

Connection: cable, 16-wire, length 10 m
Ethernet: M12, 4-pin

53800273 | RSL425-L/CU416-10

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 6.5 m

Connection: cable, 16-wire, length 10 m
Ethernet: M12, 4-pin

53800274 | RSL425-XL/CU416-10

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 8.25 m

Connection: cable, 16-wire, length 10 m
Ethernet: M12, 4-pin

53800275 | RSL425-S/CU416-25

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 3.0 m

Connection: cable, 16-wire, length 25 m
Ethernet: M12, 4-pin

53800276 | RSL425-M/CU416-25

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 4.5 m

Connection: cable, 16-wire, length 25 m
Ethernet: M12, 4-pin

53800277 | RSL425-L/CU416-25

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 6.5 m

Connection: cable, 16-wire, length 25 m
Ethernet: M12, 4-pin

53800278 | RSL425-XL/CU416-25

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 8.25 m

Connection: cable, 16-wire, length 25 m
Ethernet: M12, 4-pin

53800279 | RSL425-S/CU416-300-

WPU

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 3.0 m

Connection: 0.3 m cable with 16-pin connector
Ethernet: M12, 4-pin

53800280 | RSL425-M/CU416-300-

WPU

1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 4.5 m

Connection: 0.3 m cable with 16-pin connector
Ethernet: M12, 4-pin
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53800281 | RSL425-L/CU416-300- |1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
WPU tective field range max. 6.5 m
Connection: 0.3 m cable with 16-pin connector
Ethernet: M12, 4-pin
53800282 | RSL425-XL/CU416-300- |1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
WPU tective field range max. 8.25 m
Connection: 0.3 m cable with 16-pin connector
Ethernet: M12, 4-pin
Tab. 17.3: Components as spare parts
Part no. |Article Description

Scanner units

53800102 | RSL420-S 1 OSSD pair; 10 field pairs; 4 10s; protective field range max. 3.0 m

53800106 | RSL420-M 1 OSSD pair; 10 field pairs; 4 10s; protective field range max. 4.5 m

53800110 | RSL420-L 1 OSSD pair; 10 field pairs; 4 10s; protective field range max. 6.5 m

53800114 | RSL420-XL 1 OSSD pair; 10 field pairs; 4 10s; protective field range max.
8.25m

53800142 | RSL425-S 1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 3.0 m

53800144 | RSL425-M 1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 4.5 m

53800146 | RSL425-L 1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-
tective field range max. 6.5 m

53800148 | RSL425-XL 1 OSSD pair; 10 field pairs; 4 10s; data output for navigation, pro-

tective field range max. 8.25 m

Connection units

53800118 | CU416-5000 Connection: cable, 16-wire, length: 5 m
Ethernet: M12, 4-pin
53800119 | CU416-10000 Connection: cable, 16-wire, length: 10 m
Ethernet: M12, 4-pin
53800120 | CU416-25000 Connection: cable, 16-wire, length: 25 m
Ethernet: M12, 4-pin
53800125 | CU411-RS4 RS4 adapter
Connection: cable, 11-wire, SUB-D 15, length: 0.6 m
Ethernet: M12, 4-pin
53800180 | CU416-300-WPU Connection: cable, 16-wire, with M30 connector, length: 0.3 m

Ethernet: M12, 4-pin
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Tab. 17.4:

Accessories

Part no.

Article

Description

Connection technology — Connection cables

50137263 | KD S-M30-16A-V1-050 | Connection cable, 16-pin, 5 m
50137264 | KD S-M30-16A-V1-100 | Connection cable, 16-pin, 10 m
50137265 | KD S-M30-16A-V1-250 | Connection cable, 16-pin, 25 m

Connection technology — Connectors/sockets

50137261

S U-M30-16A-M

Connection connector, 16-pin

50137262

D U-M30-16A-M

Connection socket, 16-pin

Connection technology - Interconnection cables

50135080 | KSS ET-M12-4A-RJ45- |Interconnection cable RJ45, 2 m
A-P7-020

50135081 | KSS ET-M12-4A-RJ45- |Interconnection cable RJ45, 5 m
A-P7-050

50135082 | KSS ET-M12-4A-RJ45- |Interconnection cable RJ45, 10 m
A-P7-100

50135083 | KSS ET-M12-4A-RJ45- |Interconnection cable RJ45, 15 m
A-P7-150

50135084 | KSS ET-M12-4A-RJ45- |Interconnection cable RJ45, 30 m

A-P7-300

Connection technology — Adapters

50134656 | RSL 400 M12 adapter Adapter for the simple connection of an Ethernet cable to the front
side of the device.

Mounting technology

53800130 | BTUSOOM Laser scanner mounting system for vertical and horizontal align-
ment

53800132 | BTF815M Mounting bracket for floor mounting; scanning height 150 mm
Mounting of safety sensor only in combination with BTUS00M

53800133 | BTF830M Mounting bracket for floor mounting; scanning height 300 mm
Mounting of safety sensor only in combination with BTUS00M

53800134 | BT840M Mounting bracket for corner mounting on posts (chamfered corner)
Direct mounting of the safety sensor

53800135 | BT856M Mounting bracket for corner mounting on posts
Direct mounting of the safety sensor

53800131 | BTP80OM Loop guard for optics cover
Only in combination with BTU8800M

53800136 | BTUS04MA Mounting plate for mounting system RS4 / ROD4

53800137 | BTBOOMA Drilling template for adapter plate, RS4/ROD4

Cleaning fluids

430400 |Cleaning set 1 Cleaning fluid for plastic, 150 ml, cleaning cloths, 25x, soft, fuzz-
free
430410 Cleaning set 2 Cleaning fluid for plastic, 1,000 ml, cleaning cloths, 100x, soft, fuzz-

free
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EU/EG-
KONFORMITATS-
ERKLARUNG

Hersteller:

Produktbeschreibung:
Sicherheits-Laserscanner fiir
Personenschutz,
Beriihrungslos wirkende
Schutzeinrichtung,
Sicherheitsbauteil nach
2006/42/EG
Anhang IV
RSL 400
Seriennummer siehe Typschild

Die alleinige Verantwortung
fir die Ausstellung dieser
Konformitatserklarung  tragt
der Hersteller.

Der oben  beschriebene
Gegenstand der Erklarung
erfillt  die  einschldgigen
Harmonisierungsrechts-
vorschriften der Union:

Angewandte EU-/EG-
Richtlinie(n):

2006/42/EG (*1)
2014/30/EV
2014/53/EU (*2)

& Leuze electronic

EU/EC
DECLARATION OF
CONFORMITY

Manufacturer:

Leuze electronic GmbH + Co. KG
In der Braike 1, PO Box 1111
73277 Owen, Germany

Description of product:

Safety Laser Scanner for
personnel protection,
Active opto-electronic

protective device,
safety component in acc. with
2006/42/EC annex IV
RSL 400
Serial no. see name plates

This declaration of conformity
is issued under the sole
responsibility of the
manufacturer.

The object of the declaration
described above is in
conformity with the relevant
Union harmonisation
legislation:

Applied EU/EC Directive(s):
2006/42/EC (*1)

2014/30/EU
2014/53/EU (*2)

the sensor people

DECLARATION
UE/CE DE
CONFORMITE

Constructeur:

Description de produit:
Scanner laser de sécurité pour
la protection des personnes,
Equipement de protection
électrosensible,
Elément de sécurité selon
2006/42/CE annexe IV
RSL 400
N° série voir plaques
signalétiques
La présente déclaration de
conformité est établie sous la
seule responsabilité du

fabricant.

L'objet de la déclaration décrit
ci-dessus est conforme a la
législation d'harmonisation de
I'Union applicable:

Directive(s) UE/CE
appliquées:
2006/42/CE (*1)

2014/30/UE
2014/53/UE (*2)

Angewandte harmonisierte Normen / Applied harmonized standards / Normes harmonisées appliquées:

EN ISO 13849-1: 2008 (Cat.3 PL d) (*1)
EN 62311: 2008

EN 62061: 2005 + A1: 2013 (SILCL 2) (*1)
EN 60950-1: 2006 + AC: 2011

EN 61496-1: 2013 (*1)
EN 55022: 2010 + AC: 2011

Angewandte technische Spezifikationen / Applied technical specifications / Spécifications techniques

EN 61508-1/-2/-3/-4: 2010 (SIL 2) (*1)

Notified Body

appliquées:
IEC 614963 (ed.2) (*1)

EN 61496-1: 2013

(*1) TUV-8UD PRODUCT SERVICE GmbH, Zertifizierungsstelle, Ridlerstralie 65, D-80339 Munchen, NB 0123, Z10 15 06 68636 004

Dokumentati dchtigter ist der g H

. Kontakl: quality@leuze de.

Authorized for documentation is the stated manufacturer, contact: quality@leuze.de.

Aulerisé pour doc: 1 estle

ir déclaré, contact: qualily@ieuze.de

2014/30/EU verdffentlicht: 29.03.2014, EU-Amtsbiatt Nr. L 96/79-106; 2014/30/EU published: 29.03,2014, EU-Journal No. L 96/79-106; 2014/30/UE publié: Journal EU n° L 96/79-106
(*2) Nur fir Geréte mit Funkmodul; Only for devices with radio module; Seutement pour les appareils avec module radio.

A2.06. oA}
Datum / Date / D;

Ufrich Balbach’

Geschaftsfiihrer / Managing Director / Gérant

A/

i.A. Fabien Zelenda
Quality Management Central Functions

Leuze electronic GmbH + Co. KG Leuze electronic GmbH + Co. KG, Sitz Owen, Registergericht Stutigart, HRA 230712

in der Braike 1 Parstnlich haftende Gesellschatterin Leuze slectronic Geschaftsfihrungs-GmbH,
D-73277 Owen Sitz Qwen, Registergericht Stuttgart, HRB 230650
Telefon +49 (0) 7021 573-0 Geschdftsfihrer: Ulrich Balbach
Telefax +49 (0) 7021 573-199 USt.-1dNr. DE 145912521 I Zolinummer 2554232
info@leuze de Es gelten ausschlielich unsere aktuellen Verkaufs- und Lieferbedingungen
www.Jeuze.com Only our current Terms and Conditions of Sale and Delivery shall apply
LEQ-ZOM-148-07F0
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